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Executive Summary TC "Executive Summary" \f C \l "1"  
Knowledge of shoreline change is a basic element in the management of coastal parks.  It has value in understanding the functioning of the natural resources and in the administration of the cultural resources.  The direction and magnitude of shoreline change can be monitored through the application of a protocol that tracks the seasonal position of the high tide swash line under conditions of temporal sampling.  Spring and fall surveys conducted in accordance with standard operating procedures will generate shoreline position data sets that can be incorporated within a data matrix and analyzed for temporal and spatial variations.  The format of the data sets will be standardized and assembled by a data manager into a national data base for subsequent retrieval and additional analysis.  The overall goal is to create a replicable means of data gathering that is efficient, adheres to scientific principles, and meets the management needs of the coastal parks. 
Protocol Narrative
The following table lists all changes that have been made to this Protocol Narrative since the original publication date.  Any recommended or required changes added to the log must be complete and concise and promptly brought to the attention of the Project Leader.  The project leader will review and incorporate all changes, officially complete the revision history log, and change the date and version number on the title page.  For complete instructions, please refer to SOP#10 – Revising the Protocol, Section II. 

Version 1.00 - August 2007
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	New Version #
	Previous Version #
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Background and Objectives TC "1.1

Background and Objectives" \f C \l "2" 
Introduction
 TC "1.1.1
Introduction" \f C \l "3" 
A major issue in all coastal parks is the magnitude and rate of shoreline change.  This condition affects the quality of the natural and cultural resources as well as the general infrastructure present in the coastal parks.  It is among the most basic concerns of being at the shore.  Bird (1985) indicates that at least 70 % of the world’s sandy shorelines are eroding and the percentage is expected to increase because of sea-level rise and sediment manipulation by human actions.  Working Groups within the Intergovernmental Panel on Climatic Change suggest that the rate of sea-level rise will increase from 18 to 59 cm during the present century (IPCC,Working Group 1, 2007) and that shoreline change will be an immediate consequence of this inundation (IPCC, Working Group II., 2007).  New coastal geomorphological models are emerging that consider the effects on sea-level rise on shoreline change and landform evolution (Arnott, 2005).  They are both a guide to the potential effects of continuing global change and a plea to gather data appropriate to the testing and calibration of the models.  They are harbingers of the concern and interest in the quality of the coastal system, in the shepherding of coastal resources, and in the data sets describing these resources.  

As part of the congressionally-mandated Natural Resource Challenge, the National Park Service (NPS) has created thirty-two monitoring Networks to ensure the systematic collection and use of scientific data in managing the nation’s parks (NPS NCBN 2003).  Within this structure, the Northeast Coastal and Barrier Network (NCBN) is developing a series of scientific protocols to address a variety of natural resource issues appropriate to coastal locations. This document represents the first of several protocols for long-term geomorphological monitoring in the eight parks that comprise the NPS NCBN (Figure 1).  The initial protocol focuses on the collection and analysis of the ocean shoreline position.  Additional protocols will address issues related to coastal topography and estuarine shorelines.

Goal and Objective

A primary goal of the NCBN coastal geomorphological program is to provide information to park managers and to improve the understanding of the dynamic nature of coastlines, including the temporal and spatial patterns of change in NCBN parks, for use in management decisions and in describing the condition of marine and coastal areas.  The specific objective of this shoreline position monitoring protocol is to identify the seasonal, annual, and long-term trends and variability of shoreline position in the Network parks as part of the basis for understanding the coastal geomorphological system.
The NCBN coastal geomorphology program and its protocols are based upon three underlying principles
1. All protocols developed by the Network must have a scientific foundation.  Collaboration with the scientific community will ensure that all geomorphologic monitoring protocols are based on well-established scientific principles of coastal characterization, processes, and response.  Because coastal geomorphology is a complex subject, valid interpretation of the data will require the active involvement of knowledgeable coastal scientists. 
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Figure 1. Locations of the eight NPS units in the Inventory and Monitoring Program of the Northeast Coastal and Barrier Network.

2. Data must address significant park management issues.  Park managers and natural resource staff were active participants in the planning and scoping process in the development phase of the geomorphologic protocols.  The objectives identified in this protocol reflect a consensus of issues considered relevant at the park level.  This protocol focuses on recording and assembling the geomorphological dataset to enable better- informed management decisions.  

3. All protocols and their components must be feasible to implement at the Network level.  Although the scientific and management value of the monitoring data were both critical factors in determining which vital signs or indicators were selected for monitoring, the practicality and feasibility of implementation across the Network were important as well.

Changes in shoreline position in the Network parks were identified by coastal scientists and park managers as geomorphologically significant, and the type of observational data that can easily be assembled and quickly and effectively incorporated into park management operations.  Among these important considerations are:

· Changes in shoreline position serve as a surrogate for sediment budget measurements.
· Changes in shoreline position document the seasonal, annual, and long-term trends in beach displacement. 

· Shoreline position monitoring is compatible with the historical record and ongoing measurement. 

· Shoreline position monitoring is feasible to implement at the Network level with existing technology and equipment.
· Shoreline position data are readily used at the park level in various management applications.

The ocean shoreline position protocol includes a number of highly-detailed standard operating procedures (SOPs). They are intended to ensure the consistency and repeatability essential to any long-term monitoring program.   These SOPs will be modified and revised as technology improves and better methods for monitoring coastal geomorphological change are developed.
The Ocean Beach-Dune Ecosystem

 TC "1.1.2  
The Ocean Beach-Dune Ecosystem" \f C \l "3" 
The basis for the ocean shoreline protocol is the beach-dune conceptual model (modified from Roman and Barret 1999) which relates the physical processes and cultural impacts (agents of change) to the vectors of change (stressors) and to the responses of the coastal ecosystem (Figure 2). Fundamental to the model is an awareness that the coastal system is dynamic and that it is interacting at a variety of geographical and temporal scales.  The model consists of an assemblage of natural and cultural agents and processes that generate characteristics of the coastal landscape.  As the relative magnitude of the agents and processes vary, they cause alterations to the hydrology and sediment budget and consequently to the landscape.  Furthermore, there is a continuous interaction and feedback amongst the evolving components that drive additional changes and alterations. A primary manifestation of the alteration is a shift in shoreline position and modification of the beach-dune topography. These coastal geomorphological changes result in an ecosystem response that incorporates changes in the physical environment and in the community structure and function (Figure 2).
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Figure 2.  The Ocean Beach-Dune Ecosystem Model illustrates the relationships amongst the agents of change, stressors, and ecosystem response. (after Roman and Barrett 1999)

The primary natural disturbances that drive geomorphological change are sea-level rise, sediment supply, and wave climate.  These natural factors influence coastal geomorphological response at different temporal scales including individual events (storms), cyclic variations (seasonal), and annual and multi-year (long-term) trends (Carter 1988, Psuty and Ofiara 2002).  One of the effects of the long-term trend of sea-level rise is inland displacement of the shoreline.  When coupled with erosion produced by a prevailing sediment deficit, the rate of inland shoreline displacement is increased (National Research Council 1987; Warrick 1993). Whereas sea-level rise and sediment supply are the primary factors causing the change, wave climate is responsible for the nearshore processes of waves and currents that steer the local sediment transport and consequently control the site-specific shoreline configuration (Trenhaile 1997). 

Local conditions such as the underlying geologic framework, bathymetry, offshore topography, and sediment sources and sinks interact with the primary factors and the coastal processes to influence the characteristics and the rates and direction of the coastal system alterations (Honeycutt and Krantz 2003). In addition to natural causes, coastal changes are often accelerated by human perturbations such as dredging and channel relocation, groins and jetties, and beach and dune manipulation (Nordstrom 2000). These human influences can cause alterations to waves, currents, and availability and mobility of sediment. The combinations of natural processes and anthropogenic modifications interact to cause significant morphological change that leads to ecosystem response. 

Coastal ecosystem response may consist of adjustments to resource patterns and dynamics, and may eventually lead to the loss of fixed natural resources (Roman and Nordstrom 1988). These responses often elicit secondary changes in ecosystem structure or function.  Structural changes in species composition or competitive interactions generally reflect landscape-level alterations in the quantity and quality of specific habitats.  Similarly, functional changes in productivity or nutrient cycling may occur as a product of storm events and the associated reduction in habitat complexity.  More subtle physical changes also include alterations in geo-chemical and hydrologic conditions, such as groundwater quality and quantity. The magnitude and scope of the resultant coastal ecosystem response is complex, highly variable, and can often be cumulative. At the extreme, this includes the alteration of habitats and of core ecosystem processes. For example, erosion of an existing shoreline may create new aquatic habitat, or overwash fans may fill in a wetland environment to create new terrestrial habitat. 

The Process of Evaluating Vital Signs TC "1.1.3 
Process of Evaluating Vital Signs" \f C \l "3"  
Geomorphological change is important to the evolution of the coastal ecosystem, and in some cases, when it affects natural and cultural resources, recreational features, and facilities or infrastructure, the change presents complex challenges to park management.  In order to address the full range of scientific and management concerns, multiple scoping workshops were convened to identify issues of general importance and to make specific recommendations for monitoring.  Throughout the scoping process, the lack of adequate data to track and respond to geomorphologic change was consistently identified as a high priority management issue. 

Demonstrating the complexity of the coastal geomorphologic process, twenty-nine potential monitoring variables (vital signs) of geomorphologic change were identified by the workshops (NPS NCBN 2003).  Following the workshops, the number was reduced by combining similar indicators and eliminating redundant items. The remaining fourteen vital signs were evaluated and ranked for data value and feasibility of implementation at the Network level (Table 1).  
Shoreline position and elements of the coastal topography were consistently identified as of high information value and capable of monitoring with existing methods.

The Elements of Monitoring Coastal Shoreline Position

 TC "1.1.4 
Monitoring Coastal Shoreline Position" \f C \l "3" 
Detailed knowledge of the hydrodynamic forcing of sediment mobilization, transport, and deposition, and measurements of morphologic change and ecosystem response at the park level are key to understanding the coastal geomorphology of NCBN parks (Allen 2000).   Although a number of these geomorphological processes and responses are somewhat difficult to measure and monitor, there are several, such as shoreline position, that have high value (Table 1), can be measured effectively, and can be used to address park management issues. 
From a scientific perspective, shoreline position represents the morphological response of wave and current processes acting upon sediment supply (Komar 1998; Short 1999). Understanding the dynamics of changes in shoreline position over time, through standardized data collection, will provide a scientific basis for informed resource management (National Research Council 1995).  Additionally, historical shoreline positions data exist for many of the NCBN parks, thereby providing the opportunity for long-term comparison.  T TThe assemblage of reliable and consistent data enables robust statistical analysis, yielding a better understanding of episodes, cycles, and trends (Colwell and Thom 1994; Dolan and Hayden 1983).

Shoreline monitoring provides knowledge of the spatial and temporal variation in sediment transfers and sediment budget and creates a fundamental database for use in park management.  Collecting a record of the changes in the shoreline position over time chronicles variation in sediment supply and distribution (Allen, et. al. 1995).  The collection of the shoreline position twice a year, in the early spring (the fully developed winter beach) and the early fall (the fully developed summer beach), leads to the accumulation of a time series of seasonal shoreline positions that represent the annual theoretical maximum and minimum configurations of the beach. Each annual pair of shorelines portrays the magnitude of variation caused by the changes in the seasonal wave climate acting on the beach sediment supply.  Longer term comparisons of shoreline positions reveal changes created by differences in sediment availability and intensity of formational processes.  In addition, there are aspects of shoreline variability, such as geotemporal trends and cycles, that can only be revealed only by long term-data collection. 
The objective of the NCBN shoreline position monitoring protocol is to identify the seasonal, annual, and long-term trends and variability of shoreline position in the Network parks.  Meeting this objective will address the following questions:  

· What is the displacement of the shoreline?

· What are the seasonal dimensions of the displacement?

· What are the annual dimensions of the displacement?

· What are the long-term dimensions of the displacement?

· What are the spatial and temporal trends in the shoreline displacement?

Table 1.  The fourteen Vital Signs identified during the Northeast Coastal and Barrier Network Geomorphologic Change Workshops; they are ranked for data value and feasibility of implementation at the Network level.
	Vital Sign
	Measurement
	Monitoring Methods
	Feasibility
	Data Value

	Shoreline Position
	Shoreline position
	1D & 2D GPS, 2D & 3D Survey, Aerial Photography, LIDAR
	high
	high

	Coastal

Topography
	Dune, beach, cliff, bluff morphology
	LIDAR, Aerial Photography, 2D &3D Survey
	high
	high

	Coastal

Topography
	Edge of vegetation
	LIDAR, 1D, 2D GPS, Aerial Photography
	high
	high

	Coastal

Topography
	Landcover
	LIDAR,  2D &3D Survey
	high
	high

	Coastal

Topography
	Overwash fans/flood plains
	LIDAR, 1D & 2D GPS, 2D & 3D Survey, Aerial Photography
	medium
	high

	Coastal Topography
	Shore type
	Aerial Photography, 2D & 3D GPS, 2D & 3D Survey
	medium
	medium

	Anthropogenic

Modifications
	Locations of  structures and disturbances
	Aerial Photography, 1D & 2D GPS, 2D & 3D Survey
	medium
	high

	Marine Geomorphology
	Sediment quantity

Sediment size
	Terrestrial and Marine Sediment Samples
	medium
	medium

	Marine Geomorphology
	Geologic framework
	Acoustic Survey, Seismic Survey, 

Core Samples
	low
	high

	Marine Geomorphology
	Depths
	Acoustic Survey, Bathymetric LIDAR,

Sled survey
	low
	medium

	Marine Geomorphology
	Migrating shoals & bodies
	Acoustic Survey, Bathymetric LIDAR
	low
	high

	Marine Hydrography
	Tide range
	Local  & Regional Tide Gauge
	high
	high

	Marine Hydrography
	Relative sea level position
	Water Level Gauge
	high
	high

	Marine Hydrography
	Wave and current characteristics
	Local Gauge -Regional Gauge
	low
	high


Accomplishing the objective of this protocol requires the following steps: 1) standardization of the survey methodology, 2) design and construction of the database, 3) reporting of the assembled data and, 4) scientific analysis and interpretation.  
Historical Development of Methods used for Monitoring Shoreline Position

 TC "1.1.5 
Historical Development of Methods used for Monitoring Shoreline Position" \f C \l "3" 
Coastal mapping and the measuring of coastal features have utilized an evolving suite of data collection methods (Boak and Turner 2005). Early techniques in the United States involved the Coast & Geodetic Survey conducting surveys of the coast beginning in the early 1800s. This method was extremely labor intensive and the long time periods required to complete a survey proved to be problematic in capturing anything resembling an instantaneous shoreline position. However, these early efforts did result in systematically collected datasets that were suitable for general delineation and comparison of coastal features, and they established general baselines in many coastal areas (Graham, et al 2003). 

The development of aerial photography in the early twentieth century created the opportunity for rapid data collection and the extraction of multiple features from the images (Moore 2000). Comparison studies between ground surveys and aerial photography showed a general level of compatibility between the data (Krauss 1997). The ability to capture large geographic areas of the coast continues with space-based satellites.  Satellite technology is becoming a viable option for many coastal data acquisition purposes.  Currently, there are several studies within the NCBN to assess the utility of satellite imagery for coastal mapping.  

The last twenty years have seen a revolution in mapping sciences in general and coastal mapping sciences in particular. The development of Geographic Information Systems (GIS) allows the simultaneous display, manipulation, and analysis of multiple datasets.  In the 1980s and 1990s, GIS technology was augmented by the addition of satellite-based Global Positioning Systems (GPS), creating the opportunity for more efficient, frequent, and precise measures of geomorphological features.  Recent GPS survey approaches produce topographical portrayals with sub-meter accuracy (Pardo-Pascual, et al. 2005). Together these technologies have greatly increased the capacity for updating, analyzing, and reporting changes in coastal conditions.

The revolution in coastal mapping continued into the 1990s when LIDAR (LIght Detection And Ranging) technology was applied to the coastal zone (Krabill 2000).  The airborne laser mapping system can deliver high-resolution measurements of the entire non-vegetated beach and dune system and use the three-dimensional data to extract a variety of coastal features, including shoreline position.  LIDAR technology has evolved rapidly and systems now exist that can penetrate sparse to moderate vegetation (Wright and Brock 2002) and some shallow waters to provide detailed topography and bathymetry over large segments of coastal systems. 

NPS geomorphological monitoring has generally mirrored the developments in the coastal sciences (Allen and LaBash 1997).  In some cases, the NPS has played a major role in the development of modern, technology-based data acquisition efforts (Brock et al 2001).  Network parks were early users of GPS shoreline surveys and a park-focused NASA research experiment in the mid-1990s was one of the earliest cases of LIDAR technology applied to beach mapping. 

Currently, there are a variety of independent data collection activities underway in individual NCBN parks. At present, none of these efforts meets the rigorous data collection and data management standards established by the service-wide inventory and monitoring program. However, many of the concepts, methods, and techniques used in individual park programs are applicable to Network-wide long-term monitoring.  By providing a consistent and systematic framework for collection, analysis, and reporting, the NCBN will utilize this collective knowledge and experience from existing park programs to build a long-term, Network monitoring program. 

Sampling Design
 TC "1.2 
Sampling Design" \f C \l "2" 
Selecting the Shoreline Feature and Measurement TC "1.2.1 
Selecting the Shoreline Feature and Measurement" \f C \l "3" 
The shoreline represents the intersection between water and land surfaces.  The location of the intercept on the beach profile (Figure 3) varies due to the effects of tides, waves, and atmospheric conditions.  Shorelines may be delineated based on a datum intercept, or identification of some morphological feature, or some visual characteristic.  Multiple conventions and terms are used to describe the various positions of the intercept.  Datum shorelines such as Mean High Water (MHW) are quantitative and use a calculated identification of an exact elevation to extract the intercept (Parker 2003; Pajak and Letherman 2002).    Whereas morphologic features such as berm crest or cliff base or visual features such as the high water mark, high-tide swash line, or water’s edge are typically qualitative and are based on a visual interpretation (Figure 3).  Any of these quantitative or qualitative features may be used to represent a shoreline position under specific circumstances.

Datum-based derivations such as calculated water levels (Mean Sea level, Mean High Water, etc.) or national datums (North American Vertical Datum 1988, or National Geodetic Vertical Datum 1929)  are precise measures of shoreline position based on a specific vertical elevation (shown in combination on Figure 3).  However, the present-day needs across the Network to support data collection necessary to extract this feature at the geotemporal scale required to identify seasonal and episodic variability cause this approach to be impractical.   

On the other hand, although qualitative shorelines are less precise, their derivation is feasible for use in a long-term, Network-wide monitoring program (Pajak and Letherman 2002).  Further, with the application of a standardized and repetitive means for shoreline identification and recording, a very good comparative shoreline position can be attained.  Among the qualitative features described above, the neap high-tide swash line is consistently available, readily identified, and easily collected; and thus it is selected as the indicator of shoreline position in this protocol (Figure 4).  In the context of the NPS Network based monitoring program, a systematically planned and executed survey utilizing the high-tide swash line as shoreline position is well suited to the needs, resources, and capabilities of the program.

Properly planned and executed GPS surveys can provide sufficient data to monitor the long-term trends and variability in shoreline position. Further, the timing of the survey can be adjusted for local tides and weather conditions, making GPS surveys comparable and more convenient than many other established methods of shoreline mapping.
Geographical Extent of the Surveys TC "1.2.2 
Geographical Extent of the Surveys" \f C \l "3" 
In order to determine alongshore variability, the survey will encompass the entire length of the ocean beach at each of the Network’s ocean parks (ASIS, CACO, FIIS, and GATE).  The spatial extent includes the entire ocean shoreline, and the inlet shoreline from the oceanside to a transition area characterized by a distinct orientation change and a reduction of wave and current energies. Park specific descriptions and maps/diagrams of the survey area are included in SOP #3 – Site Location and Geographical Extent. 
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Figure 3. The relationship of the various topographical features of the beach profile to the positions of water level and vertical datums:  mean higher high water; mean high water; North American Vertical Datum 1988; mean sea level; National Geodetic Vertical Datum 1929; mean low water; and mean lower low water. 
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Figure 4 – The recent high-tide swash line (red dashed line) on the beach face.

Survey Frequency and Timing TC "1.2.3 
Survey Frequency and Timing" \f C \l "3"  

Weather induced changes in wave climate produce a distinct seasonal response in the shoreline position (List and Farris 1999).  These locational responses typically reach their peak expression around the end of the winter and summer seasons.    In order to track this seasonal variation, shoreline surveys will be conducted on a twice per year basis and timed to capture the general occurrence of the maximum seasonal (winter/summer) state.  The winter shoreline position will be collected in mid-March to late April and the summer shoreline position in mid-September to late October.  Attention should be given to local weather conditions so as not to perform the seasonal survey within one week of a storm event (SOP#4 - Survey Timing and GPS Mission Planning).
The shoreline survey should also be conducted when minimum satellite availability and satellite geometry specifications are met.  Four satellites with a maximum position dilution of precision (PDOP) equal to or less than six are the minimum recommended specifications for the survey (SOP#6 – Conducting the Shoreline Survey).   In addition there may be park specific issues such as the presence of species of concern or public activities that constrain the conducting of the shoreline survey.  Park management should always be consulted in advance when planning the survey.  Details for timing and mission planning are provided in SOP #4 – Survey Timing and GPS Mission Planning
As stated above, storm-affected beaches should be avoided when conducting the seasonal shoreline survey (Morton and Sallenger 2003).    However, storm-response shorelines provide important measures of short-term variation and can be of great value to both park managers and coastal scientists.  The protocol described here can also be applied to the storm-altered shoreline to derive supplemental measures of change.  Pre-and-post-storm shoreline position surveys should be considered whenever possible.  Because numerous storms of varying intensity and duration are expected to affect a given park in a typical year, the decision of when to conduct these additional surveys is problematic.  At this time, there is no quantifiable measure or formula to calculate what constitutes a storm event.   Local observation and judgment must be exercised in making the determination whether or not to conduct the supplemental surveys.  

Field Methods
 TC "1.3  
Field Methods" \f C \l "2" 
Field Season Preparations and Mission Planning TC "1.3.1 
Field Season Preparations and Mission Planning" \f C \l "3"  

Prior to the survey window, the entire protocol should be reviewed by the NCBN geomorphological monitoring project manager, the designated field observer at each park, and any park or Network staff or cooperators who will collect, process, or otherwise handle the shoreline data.  Immediately following the protocol review, Internet URLs should be checked and mission planning for tides and satellite availability and satellite geometry should be initiated (SOP#4 - Survey Timing and GPS Mission Planning). Field equipment should be checked (SOP#1 – Equipment Needs).  Two of the determining factors for the timing of the survey are tide and satellite availability.  Both tide and satellite availability should be analyzed and a list of potential survey dates and times established and prioritized (SOP#4 - Survey Timing and GPS Mission Planning). As the survey window approaches, extended weather forecasts should be obtained and analyzed so that storm conditions can be avoided (SOP#4 - Survey Timing and GPS Mission Planning).  It is strongly recommended that a trial survey be conducted to familiarize the surveyor with the visual expression of the high tide swash line.  A limited pre-survey test run is sufficient.
Conducting the GPS Shoreline Survey TC "1.3.2 
Conducting the GPS Shoreline Survey" \f C \l "3" 
The survey is designed to capture as closely as possible the position of the high-tide swash line (Figure 5).  Surveys along the ocean shoreline are accomplished by driving a four-wheel all 
terrain vehicle (ATV) or four-wheel-drive truck at a relatively constant speed (approximately 10 mph) along the high tide swash line. For the purposes of this monitoring program, the target
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Figure 5 – The high-tide swash line is clearly identified as a wet/dry line with wrack.

 ocean shoreline is represented as the position of the most recent and highest swash line (SOP#6 – Conducting the GPS Shoreline Survey). The GPS receiver is configured to record positions at a very short interval (typically one position per second or roughly every 5 meters) for the best representation of the shoreline position (SOP#5 - Basic GPS Settings for Position Collection).  The ATV should be driven so that the position of the antenna is located over the swash line.  At least two survey monuments or some other marker with known coordinates should be included in the survey for general accuracy assessment. Additional details are included in SOP #6 - Conducting the GPS Shoreline Survey.

Post-survey Data Download and Initial QA/QC TC "1.3.3 
Post-survey Data Download and Initial QA/QC" \f C \l "3" 
Immediately upon completion of the survey and return to the office, the GPS data file will be downloaded from the receiver to a computer hard-drive and a backup copy created (SOP#7 – Initial Post-Survey Processing).  The data should be retained on the data logger until quality checks can be made.  The downloaded data should be visually checked for general spatial integrity and the file attributes reviewed for field notations.  The Field Data Form (FDF) should be completed and reviewed.  Following all of the quality control procedures, the final shoreline data set will be sent to the NCBN data manager.

Data Management
 TC "1.4 
Data Management" \f C \l "2" 
The NCBN Shoreline Change Monitoring Protocol generates a variety of data products that will be archived in a central MS Access database, overseen and controlled by the NCBN Data Manager.  These data sets will be retrievable for broad-based usage and analysis.  To better understand the structure of the archiving system, and the type of information available, a User’s Guide to the database has been produced that describes the elements of the data input and the categories of shoreline data (Appendix A).  The User’s Guide also describes the procedures for retrieving information.  Data storage and retrieval are vital elements of the NCBN shoreline monitoring effort.
Change Calculation, Data Analysis, and Reporting
 TC "1.5 
Data Analysis and Reporting" \f C \l "2" 
Generation of Changes in Shoreline Position

The comparison of GPS shoreline positions and the quantification of their differences requires that each GPS shoreline survey produces a continuous line feature from which distances to a pre-established baseline are measured. SOP #8 (Change Calculation, Data Analysis, and Reporting) describes how a baseline is created and explains how shoreline change is calculated using the Digital Shoreline Analysis System (DSAS) (Theiler, et al., 2005).  DSAS is the recommended tool for transforming the surveyed shoreline into a data matrix of distance measurements from which temporal and spatial changes are determined. Creation of the data matrix provides the basis to characterize the dimensional changes of the entire park’s shoreline as well as subsets of the park (smaller areas of special concern).

Data Analysis and Reports

An analysis of the change of shoreline position will consist of the production of a suite of summary statistics that will describe the dimensions of the change, such as mean value and standard deviation. It will also identify the spatial distribution of the changes as a means to highlight locations of greater or lesser mobility.  Annual reports will be produced to describe the seasonal changes as well as the year-to-year variations (SOP #8).  Longer-term reports will be produced at six-year intervals to look at trends in the temporal and spatial changes, covering the general shoreline of the Park as well as areas of special concern (SOP #8).

Personnel Requirements and Training
Roles and Responsibilities TC "1.6.1 
Roles and Responsibilities" \f C \l "3" 
The NCBN is responsible for the development and implementation of the protocol and has assigned a Network staff-person as project manager.  The project manager is responsible for coordinating protocol development as well as an implementation plan and schedule that is suited to the needs of the individual Network parks.  The project manager will work closely with Network parks and their designated cooperators to develop and implement this protocol.

The shoreline position protocol is designed to utilize local staff for field data collection. The data collection is improved through the use of personnel who have a basic understanding and working knowledge of the park and its resources. Because of their familiarity with its appearance, local personnel are much better situated to perform periodic observations of the beach. Their participation will thus greatly enhance accurate and consistent identification of the shoreline feature. The use of local staff also limits or prevents the problem of schedule overlap - where Network staff and cooperators might be expected to work in multiple parks at or around the same time frame.  

Inconsistencies inherent to qualitative (visual) identification of the shoreline are reduced when the number of observers is limited.   Because it is a qualitative feature, no two observers will see or drive exactly the same shoreline.  Spatial variability due to observer interpretation must be recognized and acknowledged.  However, because an objective of the protocol is the establishment of long-term trends, it is likely that the minor inconsistencies introduced through the use of multiple observers will not seriously affect the value of the data.  Nonetheless, consistent feature identification and measurement is important and assignment of data collection to a single or small number of Network-trained observers is highly recommended.

The data management aspect of the monitoring effort is the shared responsibility of the field surveyor, the park and Network data managers, and the Network project manager. The field surveyor is responsible for field data collection, initial data download, and initial QA/QC.  The field surveyor should work closely with the Network and/or park GIS specialist for additional post-processing, differential correction, data verification and data validation, preliminary data editing, and export to the designated GIS format.  The Network project manager is responsible for data documentation (metadata), data summary, and basic analysis and reporting.  Ultimately, the NCBN geomorphologic monitoring project manager has the responsibility to see that adequate QA/QC procedures are built into the database management system and that appropriate data handling procedures are followed.

Qualifications and Training TC "1.6.2 
Qualifications and Training" \f C \l "3" 
An essential component in the collection of shoreline data is a knowledgeable, competent, and attentive field surveyor.   Because visual interpretation of the shoreline is the essential element of the protocol, the ability of the field surveyor to consistently identify the target feature is critical to accurate data collection. The field surveyor should have a basic understanding of coastal and shoreline processes, familiarity with the resource and appearance of the shoreline expression on the local beach, and competence and experience in the operation of all equipment being used in the survey. The NCBN staff will assess the situation in each park and train local staff as required. (SOP #2 - Training for Field Data Collection). 

Operational Requirements
Annual Workload and Field Schedule TC "1.7.1 
Annual Workload and Field Schedule" \f C \l "3" 
GPS surveys will be conducted in early spring (mid March to late April) and early fall (mid September to late October), a period that coincides with the peak expression of seasonal beach variability in the NCBN ocean parks.  Extreme tide and weather events will preclude the scheduling of surveys to specific annual dates. Shoreline surveys require one person, although the survey could benefit from the use of one or more additional staff if qualified persons and the necessary equipment are available.  Due to the different lengths of ocean shoreline in Network parks, time required for data collection will vary.  In general, approximately five days should be allocated to complete all requirements of each field survey. 

Facility and Equipment Needs TC "1.7.2 
Facility and Equipment Needs" \f C \l "3" 
The equipment needed for the field survey consists of a four-wheel-drive vehicle (ATV is recommended), appropriate safety gear such as helmet, goggles, and gloves, and a GPS unit capable of sub-meter accuracy, single point position collection, and post-processed differential correction (e.g., Trimble GeoXT or equivalent). If two or more surveyors work simultaneously, field equipment requirements will increase accordingly. Should a park lack the proper equipment, the Network will attempt to arrange access to the items necessary to conduct the survey.  

A computer and peripheral devices with appropriate ports and cables, GPS processing software (e.g., Trimble Pathfinder Office) for download, initial QA/QC, and export to ESRI GIS format are required to complete the initial tasks. The GIS component consists of the ESRI ArcGIS software.  Office computing needs and other equipment items are detailed in SOP #1 – Equipment Needs. 

Startup Costs and Budget TC "1.7.3 
Startup Costs and Budget" \f C \l "3" 
Startup costs consist of the ATV, the GPS unit, and if the survey is planned and executed locally, the surveyor’s time (Table 2).  If NCBN staff or their partners are required to perform the survey, staff time plus travel expenses must be included in the costs.  Equipment consists of a GPS unit, an ATV, and a computer running GPS and ESRI GIS software.  All of these items are available at Network parks.  Gasoline for survey vehicle, media for backup of data, and other such costs are considered minimal and incidental.

Table 2 – Data Collection Cost Estimates. 

	Item/Activity
	1st Year Cost
	5 Year
Total Cost
	Annual Cost
	Annual Cost per Park
	Per Survey Cost

	ATVs (4)1
	26000
	26000
	5200
	1300
	650

	GPS (4)2
	40000
	40000
	8000
	2000
	1000

	Personnel3
	12000
	60000
	12000
	3000
	1500

	Computer4 with ESRI GIS
	12000
	18400
	3680
	920
	460

	Total
	 SUM(above) \# "0" 

  

  

  

 SUM() 90000
	144400
	28880
	 SUM() 7220
	3610


1= 1 ATV for each ocean park 
2= 1 GPS per ocean park 

3= Based on 8 weeks (2 weeks per park) at GS9 
4= 1 Computer and 1 annual ESRI GIS license per ocean park

Procedure for Revising and Archiving Previous Versions of the Protocol
 TC "1.8

Procedure for Revising and Archiving Previous Versions of the Protocol" \f C \l "2" 
Over time, revisions to both the Protocol Narrative and to specific Standard Operating Procedures (SOPs) are to be expected.  Complete documentation of changes to the protocol, and a library of previous protocol versions are essential for maintaining consistency in data collection and for appropriate treatment of the data during data summary and analysis.  The MS Access database for each monitoring component contains a field that identifies which version of the protocol was being used when the data were collected. The rationale for including a narrative with supporting SOPs is based on the following:

· The Protocol Narrative is a general overview of the protocol that gives the history and justification for doing the work and an overview of the sampling methods, but that does not provide all of the procedural details. The Protocol Narrative will only be revised if major changes are made to the protocol.

· The SOPs, in contrast, are very specific step-by-step instructions for performing a given task.  They are expected to be revised more frequently than the Protocol Narrative. 

· When a SOP is revised, in most cases, it is not necessary to revise the Protocol Narrative to reflect the specific changes made to the SOP.

· All versions of the Protocol Narrative and SOPs will be archived in a Protocol Library.

The steps for changing the protocol (either the Protocol Narrative or the SOPs) are outlined in SOP #9 - Revising and Archiving the Protocol.  Each SOP contains a Revision History Log that should be filled out each time a SOP is modified to explain why the change was made, and to assign a new Version Number to the revised SOP.  The new version of the SOP and/or Protocol Narrative should then be archived in the Long Term Ecological Monitoring Protocol Library.
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Standard Operating Procedures
Standard Operating Procedure (SOP) # 1 – Equipment and Supplies

Version 1.0 (July 2007)

The following table lists all changes that have been made to this Standard Operating Procedure since the original publication date.  Any recommended or required changes added to the log must be complete and concise and promptly brought to the attention of the Project Leader.  The project leader will review and incorporate all changes, officially complete the revision history log, and change the date and version number on the title page.  For complete instructions, please refer to Section II of SOP#10 – Revising the Protocol. 

Revision History Log:

	New Version #
	Previous Version #
	Revision Date
	Author (full name, title, affiliation)
	Location in Document and Description of Change
	Reason for Change

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


This standard operating procedure (SOP) details the items needed to execute the ocean shoreline position monitoring protocol.  The ocean shoreline position protocol requires three major types of equipment, as well as a field data form and a field item checklist.  The equipment types include:

1. a sub-meter GPS system, preferably with real-time capability  

2. an offroad vehicle and mounting device to carry the GPS 

3. a PC capable of communicating with the datalogger on the GPS unit for pre- and post-survey activities. 


GPS System


Any GPS system may be used that has sub-meter precision and is capable of post-processed differential correction, or can accommodate real-time differential-correction of the survey points.  Operational settings and parts for each of the GPS systems may be different, but there are critical settings (SOP #5) and components that allow for consistent data collection across platforms. 

Essential GPS System Components: 
The minimum GPS components necessary to complete the ocean shoreline position survey include:

1. 12-channel receiver

2. Datalogger (internal or external)

3. Antenna (internal or external)

4. Batteries and Chargers

5. Cables (as needed)

6. For real-time data collection, a beacon receiver that is either stand-alone or integrated into the GPS unit

Transportation Requirements – Vehicle with spark resistor plugs
1. Off-road vehicle with GPS mount or

2. Quad or All-Terrain Vehicle (ATV) with GPS mount (Figure S1.1)

Requirements if Walking: 

1. Backpack (Figure S1.2) or

2. Lumbar Pack (Figure S1.3)

Emergency and Safety Supplies: 

1. Cell phone or radio

2. Park contact and emergency phone numbers

Only with vehicle

3. Shovels (4x4 only)

4. Wooden boards (4x4)

5. Extra fuel 
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Figure S1.1. Example of a Trimble GeoXT GPS unit, with internal antenna and datalogger, mounted on an ATV. 
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Figure S1.2. Example of backpack mount. (Trimble ProXR). (Diagram source: Trimble ProXR manual; page 52; April, 2004).
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Figure S1.3. Example of lumbar mount. (Trimble ProXR.) (Photo source: ASIS GIS lab).

Office Computer Equipment
A PC that meets the minimum specifications for running Trimble Pathfinder Office software is required. The NPS minimum standard for computer equipment meets these requirements.

Hardware Specifications:

1. Pentium 400 MHz microprocessor

2. 64 MB RAM 

3. 400 MB disk drive storage space (for software installation and data file storage)

4. CD or DVD reader/writer for hard copy data backup (SOP#7 –Initial Post-Survey Processing)

5. Port and cable for connection to the datalogger

Operating System:

Microsoft Windows 2000, XP, or XP Tablet PC edition.

Software:

A program capable of post-processing the collected field data; this is necessary if a real-time beacon receiver is not employed in the survey.

Internet Connectivity:

An internet connection (28.8kbps modem or faster) is needed for viewing the satellite almanac and tide charts (SOP #4), if not collecting real-time data, then conducting part of the differential correction (SOP #7), and maintaining the GPS software/firmware updates.

Forms and Checklist

In addition to the GPS and transportation equipment, there are field forms and SOPs used in the preparation and execution of each survey:

1. field copy of SOP#6 - Conducting the GPS Shoreline Survey

2. field copy of the Field Data Form (Form #SOP6-1)

office copy of the Field Equipment Checklist (Form #SOP1-1) 

FIELD ITEM CHECKLIST  

(Form # SOP1-1)
1. GPS Equipment

□   GPS receiver (required)

□   Datalogger, unless internal to GPS unit (required)



□   Antenna, unless internal to GPS unit (required)



□   Extension poles for antenna (recommended)



□    Ground plane, if not internal to antenna

□   Beacon receiver (required if not integrated with GPS unit and 
collecting real-time)



□   Internal datalogger batteries – fully charged (required)



□   Backup batteries – fully charged (required)



□   Antenna cable (antenna to receiver) (required if separate unit)



□   Antenna cable adapter (antenna end) (required if separate unit)



□   Battery cable (required if separate unit)



□   Receiver to datalogger cable (required if separate unit)

2.  Transportation Equipment 



□   Quad or 4x4 (required unless walking entire survey)

□   Backpack/lumbar pack (required if walking with antenna as separate 
unit)


□   Mount for external antenna on vehicle (required if separate unit)  



□   Boards/rope or tow cable/shovel  (recommended)



□   Sufficient fuel (required)



□   Extra fuel can (recommended)



□   Tire pressure gauge (recommended)

3.  Auxiliary Items

□   Cell phone or radio with charged battery (required)

□   Field copy of SOP#6 – Conducting the GPS Shoreline Survey (required)



□   Field copy of Field Data Form (required)


□   GPS receiver manual (optional)


□   Satellite availability and PDOP information (recommended)



□   List of emergency phone numbers (required)



□   List of park contact numbers (required)
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This SOP establishes the responsibility for conducting training, details the content and frequency of Network training, and identifies the target audience of training. Because there are a number of decision-making steps in the shoreline-monitoring protocol, there is a need to provide for an understanding of coastal processes as a foundation for making shoreline identification.  Training also explains and demonstrates the procedures for mission planning, operation of the GPS equipment, and post-survey data handling.  Therefore, training is the basis for consistency in the execution of this protocol.  

Implementation of Training


A critical component of the shoreline protocol is the GPS field survey of the shoreline.  Successful execution of this task is contingent on properly-trained personnel.  The shoreline survey requires specific steps in preparation, collection, and processing.  It is the responsibility of the NCBN to develop and deliver a training program to provide a scientific and technical foundation for consistent and accurate data collection.

Frequency of the Training Sessions

Training shall be conducted prior to initial implementation of the protocol and thereafter at a minimum interval of once every two years, or as needed due to staff or procedural changes.

Target Audiences

The Network shall provide training for two persons at each park.  This will establish a core of competent and qualified shoreline surveyors.  Additionally, data collection is improved when conducted by surveyors with local knowledge.  Training two persons per park also helps to reduce problems related to staffing or scheduling.

Training Syllabus

The purpose of training is to develop and maintain competence in the following:

1. Basic Coastal Geomorphology

a. Basic understanding of coastal process/response modeling

b. Fundamentals of cross-shore profile development

c. Development of swash on the beach face and its relationship with the shoreline

d. Importance of non-storm conditions for seasonal measurement

2. Mission Planning – Choosing the right time to survey – SOP #4

a. Seasonal timing

b. Tides

c. Storms

d. Survey window

3. Conducting the Survey

a. How to choose the right line

b. Obstacle avoidance

c. Dealing with shoreline perturbations


4. Using the GPS, including preparation of the equipment, setup, and field usage.

a. GPS equipment components and preparation – SOP #1

b. GPS setup and operation –SOP #5 

c. Mounting the GPS – SOP #5 

1. How to mount the antenna   

2. How to mount the datalogger

3. Receiver placement 

4. Use of the GPS with a backpack or lumbar mount

d. Datalogger Setup – SOP #5

1. Configuration

2. Begin the logging process

3. Conducting the survey

4. Collecting benchmarks

5. Finalizing the survey

e. Filling out the Field Data Form – SOP #6 


1. File naming


2. Form completion 


3. Note-taking

5.  Park specific issues

6.  Post-survey processing – SOP #7

a. Data downloading

b. Data backup

c. Initial quality assurance/quality control (QA/QC). 
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This SOP illustrates the spatial extent of the GPS shoreline position survey for each of the ocean parks in the NCBN.  The shoreline is highlighted by a solid red line in each of the figures.  The spatial extent includes the entire ocean shoreline, and the inlet shoreline from the oceanside transitioning to a distinct change in orientation and a reduction of wave and current energies.  This transition zone is approximated by the dashed red line on the figures.    A dashed green line is used to designate areas not under Park Service jurisdiction but where collection would provide valuable information, such as in updrift or downdrift regions, or in areas between park units.  Arranging for access to non-park areas is addressed in SOP#4.  All maps are displayed in coordinates corresponding to data collection, UTM NAD83 Zone 18 North for ASIS, GATE, and FIIS, and UTM NAD83 Zone 19 North for CACO.


Assateague Island National Seashore 


The ASIS shoreline extends for approximately 63 kilometers of ocean beach from Ocean City Inlet, MD to Toms Cove Hook, VA.  The northern terminus of the shoreline is at the jetty at Ocean City Inlet, MD.  There is one transition area from ocean to bay at the south end of the survey, at Toms Cove Hook, VA. This transition area continues the shoreline around the end of the hook and terminates on the bayside where there is a distinct orientation change of the shoreline and a reduction of wave and current energies.
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Figure S3.1 – Spatial extent of GPS data collection of the ASIS ocean shoreline. Image from  USACE Baltimore District and NPS ASIS.
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Figure S3.2. Spatial extent of GPS data collection of the ASIS transition zone at Toms Cove Hook, VA. . Image from USACE Baltimore District and NPS ASIS.
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Figure S3.3. Spatial extent of GPS data collection of the ASIS shoreline terminating in the north at the Ocean City Jetty.  Image from USACE Baltimore District and NPS ASIS.

Cape Cod National Seashore 

The CACO shoreline extends for approximately 87 kilometers of ocean beach from Race Point at the north to the southern end of Nauset Beach. There are a number of inlets along the ocean shoreline.  They should be surveyed into the bayside (beyond the initial orientation change) to track changes in inlet position as the spits migrate.  Both termini incorporate hook-like appendages.  They should be surveyed to beyond their distal limits to record shifts and extensions.
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Figure S3.4. Spatial extent of GPS data collection of the CACO ocean shoreline. Image from NPS CACO.
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Figure S3.5. Example of the spatial extent of GPS data collection at an inlet in CACO. Image from NPS CACO.

Gateway National Recreation Area – Sandy Hook 
The GATE-Sandy Hook shoreline extends for approximately 11 kilometers of ocean beach from the southern boundary with the township of Sea Bright, NJ to the US Coast Guard property in the north (Figure S3.6).  There is a jurisdictional transition area in the south, extending the shoreline updrift into the township of Sea Bright.  At the northern terminus, the monitoring should extend into Sandy Hook Bay to record the elongation of Sandy Hook bayward.
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Figure S3.6. Spatial extent of GPS data collection of the GATE – Sandy Hook ocean shoreline. Image from NPS-GATE
Gateway National Recreation Area – Breezy Point 

The GATE-Breezy Point shoreline consists of the approximately 3.5 kilometers of ocean beach at Breezy Point and 4 kilometers of ocean beach at West Beach and Jacob Riis Park (Figure S3.7).  Between these parks is a jurisdictional transition area fronting the Breezy Point Cooperative that is integral to the understanding of the shoreline change.  The distal end of Breezy Point should be monitored into the bayside, including any beach accumulations west of the jetty.  The eastern end of the survey is at the groin at the eastern end of Jacob Riis Park.
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Figure S3.7. Spatial extent of GPS data collection of the GATE – Breezy Point ocean shoreline. Image from NPS-GATE
Gateway National Recreation Area – Staten Island 

The GATE-Staten Island shoreline is approximately 4 kilometers of ocean beach at Great Kills Beach, approximately 0.5 kilometers of beach at Miller Field Beach, and approximately 1.0 kilometer of beach at Fort Wadsworth (Figure S3.8). The westernmost end is the bulkhead at the boat basin.  The easternmost end is the groin near the Verrazano Narrows Bridge. Between these park sections are jurisdictional transition areas on privately-owned and New York City properties.  The totality of the public and private shoreline should be monitored as a continuous system.  
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Figure S3.8. Spatial extent of GPS data collection of the GATE – Staten Island ocean shoreline. Image from NPS-GATE
Fire Island National Seashore 

The FIIS shoreline extends for approximately 51 kilometers of ocean beach from Democrat Point to Moriches Inlet (Figure S3.9).  There are transition areas to the bay at both termini of the island.  The western transition area is the expanding spit beyond the Fire Island Inlet jetty at the transition from ocean to bay processes.  The eastern transition area is beyond the Moriches Inlet jetty at the transition from ocean to bay processes.
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Figure S3.9. Spatial extent of GPS data collection of the FIIS ocean shoreline. Image from Suffolk County, NY and NPS FIIS.
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The objective of this Standard Operating Procedure is to detail the process for selecting the temporal window for conducting the survey. The spring and fall seasons are the most likely times of the narrowest and widest beaches for the year, respectively (Trenhaile 1997). There is an opportunity to pre-select a survey period within these seasons that will maximize the opportunity to capture the seasonal variation. A standardized GPS survey window allows for comparability of the seasonal data set by collecting similarly-derived shorelines each year. 



The comparability of shoreline positions collected with GPS equipment depends greatly on the timing of the record. The variables that determine the timing within the window are either predictable or observable and can be established in the preceding months, weeks, or days to maximize the repeatability and the efficiency of the survey. This SOP describes the procedure for the long-range identification of neap tide conditions as well as the satellite availability and geometric configuration (PDOP). It establishes the basis for short-term evaluation of storm conditions that may affect shoreline position. It addresses the variety of local resource-related variables that may constrain conducting the survey, such as endangered species zones or accessing restricted areas.  

1. Creating the Survey Window 

One objective of this protocol is to record the seasonal change in shoreline position.  Over the course of a year, a sandy beach goes through a landward and seaward oscillation as the land/water surface contact (the shoreline) varies in position based on wave energy, sediment supply, and water level.  These seasonal oscillations result in a narrowing and broadening of the beach.  Observations of past summer and winter beaches at the Sandy Hook Unit of Gateway National Recreation Area demonstrate that beaches are at their narrowest by the middle of April (end of winter) and widest near the beginning of October (end of summer).  Based on these observations and the general trends on other beaches in the Northeast Coastal Barrier Network, the optimal time for recording the seasonal oscillation of the beach is a six-week window in mid-March to late April and in mid-September to late October.
2.  Applying the neap tide variable 


The NCBN parks have semidiurnal tides; there are two high tides and two low tides each day. Each month there are two periods when the difference between high and low tide (the tidal range) is at a maximum, SPRING TIDE, and when it is at a minimum, NEAP TIDE (Figure S4.1).  There are also periods of mixed tides, when there is not a clean neap/spring signal. Times of elevated water levels relative to spring tide have the potential to have wave-generated run-up (swash) overtop the berm crest and spill onto the berm surface. Times of reduced tidal range, such as neap tide, minimize the water level variations within the monthly tidal cycle and therefore minimize variations in the shoreline position.  Therefore, the neap high-tide swash line provides an optimal reference line because it will form on the beachface will represent similar shoreline positions (SOP#6 – Figure S6.1).  Consequently, the opportunity for shoreline collection in the six-week window is any day 1) within three or four days of a neap tide, or 2) any day in a mixed tide where water level elevations are less than those that occur within three days of the peak spring tide. For example, the tidal ranges over a six-week period in Figure S4.1 show that on the order of eighteen days will be excluded by the spring tide water levels, leaving a potential twenty-four days for surveying in each seasonal window. 
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Figure S4.1. Predicted semi-diurnal tide levels during a six-week window at a coastal Virginia site (source: NOAA http://co-ops.nos.noaa.gov website).  There are two uneven high and low tides each day.  The spring tides occur on March 28th, April 10th and April 25th.  The highest spring tide occurs on April 10th.  The neap tides occur on March 19th, April 3rd, and April 18th.  The red line is the water level threshold established three days on either side of the peak spring tide.  The days available for surveying are highlighted in translucent green. Moon phases associated with the tides are displayed at the top of the graph.  The solid moon symbol represents full moon; the open symbol is new moon.
To determine the predicted tides for the six-week survey window:

1. Go to the predicted tide calculations available at the following NOAA website:  http://co-ops.nos.noaa.gov
2. Select Products →Tides → Observed Data – Active Stations

3. Select the station according to its Station ID:

•
ASIS – 8557380 Lewes, DE or 8631044 Wachapreague Channel, VA

•
GATE – SHU – 853160 Sandy Hook, NJ

•
GATE – New York – 853160 Sandy Hook, NJ

•
FIIS - 853160 Sandy Hook, NJ

•
CACO – 8449130 Nantucket Island, MA

4. Set “Data Units” to feet 

5. Set “Time Zone” to LST (local standard time)
6. Select  MLLW as the datum
7. Tide data can only be displayed in 31-day increments.  Set Begin date to one week prior to the first day of the six-week survey window, and the End date to one month following that date.
8. Select View Plot for graphical form or View Data for tabular form. 
9. Repeat the process, advancing the Begin date forward by one month until the End date encompasses one week after the last day of the six-week survey window.

Within each of the six-week survey windows designated for the spring and fall surveys, there will many available survey days around the dates of neap tide water levels.  The selected survey day should be the earliest convenient day in the window to allow for rescheduling if necessary.
3.  Applying the Variable of Satellite Availability 

The GPS data used to record shoreline positions are derived from the time signals sent from satellites.  Each surveyed position requires simultaneous readings from a minimum of four satellites (Trimble manual; p. 21; April, 2004).  Five or more satellites will improve accuracy slightly.  More important than the finite number of satellites is the combination of their number and their geometry, called PDOP (position dissolution of precision).  PDOP is a unitless value that describes the accuracy of the derived position based on satellite count and geometry.  This numerical value may vary during the course of a survey and thus it needs to be considered in the date and time selection.  A PDOP between zero and six is necessary to collect accurate and precise shoreline positions.


PDOP is a predictable value that can be plotted for the planned survey day.  To view a PDOP plot, open the “Quick Plan” in Trimble Pathfinder Office (Figure S4.2) or access the satellite predictions by downloading the free mission planning software from the Trimble website (http://www.trimble.com).  This plot identifies predicted PDOP values in advance of the survey.  The “Quick Plan” plot represents the potential PDOP; this number will be increased (worsened) if the GPS receiver/antenna has an obstructed view of the sky, or if satellites become unavailable.  PDOP fluctuates throughout the day as the satellites move in their orbits and change their relative geometry.  PDOP values are generally within the zero to six threshold at all times in the Northeastern Parks, with occasional values greater than six near midday.  Predictions of PDOP value are valid for a maximum of thirty days in advance.
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Figure S4.2.  An example of the distribution of PDOP values using the Trimble Quick Plan software.  PDOP values between 0 and 6 meet the survey criteria.  The red line is the threshold PDOP value of 6.

To obtain a prediction of PDOP prior to the survey:

1.  On the Trimble website http://www.trimble.com/gpsdataresources.shtml, click “GPS almanac in SSF file format.” 
2. When prompted, Save the File to Disk in the folder C:\Program Files\Common Files\Trimble\Almanacs.
3.  Open the Trimble Pathfinder Office Software (TPO), or The Trimble Planning Software (TPS) – Planning Utility available at http://www.trimble.com.  

4. Choose Utilities → Quick Plan (TPO) or the File → Station (TPS).
5. Select the date corresponding with the first day in the survey window.

6. Select location of the city nearest the survey site, or enter coordinates within the park.

· ASIS – Norfolk, VA

· GATE AND FIIS – New York, NY

· CACO – Provincetown, MA 

7. Choose Options → Almanac, select the SSF file type, and browse to the almanac file downloaded in step 1.  Click ‘OK’.
8.  Choose Options → Time Zone and select Eastern Std USA.  Click ‘OK’.

9.  Choose Options → Elevation Mask, and enter “15.”  Click ‘OK’.

10.  Choose Graphs → PDOP or ‘DOP – Position.’
11. Verify that PDOP is between zero and six for at least the majority of the survey day. If the PDOP frequently exceeds six, reschedule the survey to the next day in the survey window, and repeat the above steps.  

4.  Evaluation of a Storm Event on the Survey Window – 


Because the objective of this monitoring protocol is to track long-term changes in the shoreline position, surveys should not occur within one week after a storm event.  If the survey were to occur after a recent storm the shoreline position might represent short-term changes, and not the net or longer-term change in position due to changes in sediment budget.


 A storm event, for this protocol, is defined as an event that produces an actual tide level of greater than one foot (0.32 meters) above the predicted high tide (Figure S4.3).  A storm surge of greater than one foot at high tide may significantly displace the beach face and the subsequent position of the swash line. It can take up to a week for the beach to recover.  Because the objective of this Protocol is to track long-term changes related to sediment supply, and not short-term storm-related changes, it is necessary to allow the full recovery time prior to surveying.
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Figure S4.3. The depiction of water level and surge at Lewes, DE for the period February 23rd – February 25th, 2005 (Source: NOAA http://co-ops.nos.noaa.gov).  The horizontal dark green line represents the one foot surge threshold.  Feb 23rd – Feb 24th at noon would be acceptable survey days. On February 24th at 9pm, a surge (light green line) of greater than one foot occurs at high tide, and therefore the day is classified as stormy.  The survey should not occur within one week of this condition.


Storm surge elevation is determined by comparing the actual vs. predicted tides at the local NOAA tide gauge. The difference between the two data points represents the change in elevation of the water due to local conditions, referred to as surge. Stations to be used for surge calculation were selected because they have similar tidal ranges (approximately 5-6 feet (1.6-1.9 meters)) and therefore the one-foot surge threshold is consistent and proportional to this range. 


Beginning six days prior to the planned survey day:

1. Access the NOAA tide gauges through the CO-OPS website at http://co-ops.nos.noaa.gov .  

2. Select Products →Tides → Observed Data – Active Stations
3. Select the appropriate station:

· ASIS – 8557380 Lewes, DE or 8631044 Wachapreague Channel, VA

· GATE – SHU – 853160 Sandy Hook, NJ

· GATE – New York – 853160 Sandy Hook, NJ

· FIIS – 853160 Sandy Hook, NJ

· CACO – 8449130 Nantucket Island, MA

4. View the plot of water levels.  The data may also be viewed in tabular form by clicking the Data Listing link.  The difference between the Prediction and Actual Observation is the Residual, or storm surge.  It is this residual value that must not exceed one foot at high tide in the week prior to the chosen survey day.  If the presence of a storm surge prevents the shoreline survey from occurring during the allotted timeframe, reschedule the survey to the next convenient day in the survey window.
5. Steps 1-4 should be repeated four and two days prior to the survey and on the morning of the survey because the site only displays information for the previous two days.

5.  Resource Related Issues – A complete shoreline position survey requires access to the beachface over the course of the survey.  There may be time periods when access may be restricted to portions of the beach due to resource management issues that overlap with the survey window, such as periods of endangered species nesting, or park activities.  Advanced planning is required to ensure complete spatial coverage.


a. Rare, Threatened, and Endangered Species – If the beaches are closed for resource related issues such as bird nesting, surveying the shoreline may require the assistance of Natural Resource staff.  The surveyor may require an escort through these areas, or the shoreline may need to be walked.  If there are substantial areas that must be walked, allow extra time for the survey.  If access to the shoreline will be completely restricted, plan the survey for an alternate day.


b. Other Constraints – There may be access restrictions or other activities that will need to be addressed through park management.  Scheduled events on the beach may restrict vehicular access to portions of the shoreline.  If an event is planned on the survey day, allow extra time to walk the survey, or move the survey to one of the other days in the survey window.

6.  Points of Contact – Resource and other related issues may require cooperation between multiple agencies and divisions within the shoreline survey area.  A contact list should be kept up-to-date and stored with the GPS equipment.  Contact should be made with any cooperating or neighboring agency, including management at State Parks, County Parks, other Federal Agencies, or other jurisdictional partners, in the weeks prior to the survey.  

7.  References

Trenhaile, A. S., 1997.  Coastal Dynamics and Landforms.  New York, Oxford University Press.
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This SOP details the critical settings of the sub-meter GPS system for collecting the position of the shoreline and reference points, and gives a specific example of settings for the Trimble GeoXT.  There are a number of parameters that need to be preconfigured within the GPS system so that data collection is within the sub-meter quality specification.  Additionally, standardizing the criteria for collecting GPS positions assures that the survey is replicable and comparable.  Once the datalogger is configured, the settings should be re-confirmed immediately prior to conducting the survey.  

I. Critical GPS System Settings


The following values need to be set on any GPS unit used to execute the ocean shoreline position protocol.  They are set on the GPS unit prior to the survey, through a variety of menus identified below.  They are identified here as part of the necessary inputs.

LOGGING SETTINGS


1. Point feature – 1 second between points (default is 5) 
The timing of Point Features indicates the frequency at which observations will be recorded, usually applies to collecting at a monument or reference point.


2. Line feature – 1 second between points (default is 5)
Similar to Point Features, the Line Feature setting determines the frequency of points along the line.  This is the setting that is used for mapping a continuous feature, such as the shoreline.


3. Minimum positions per observation – 12 positions

The GPS system uses a minimum number of positions to determine an individual point / vertex.  A greater number of observed positions results in a more accurate feature. The setting value was determined to balance accuracy and field time.


4. Logging options – log all data available


5. Elevation mask – 15 degrees (default value)

The elevation mask is the angle relative to the horizon above which satellites will be used to generate the GPS positions.  Satellites very low on the horizon degrade the PDOP and have signal errors due to increased distance that the signal travels through the atmosphere, and should therefore not be used.


6. SNR (Signal to Noise Ratio) – 4.0 (default value)

The signal to noise (SNR) ratio is a representation of the amount of usable information received versus the amount of discarded information (noise). A threshold of 4.0 is necessary to achieve sufficient signal for sub-meter positions.

7. PDOP mask – 6.0 (default value)

The PDOP value is the unitless representation of satellite geometry.  A PDOP threshold of 6 is necessary to achieve sub-meter accuracy.


8. Apply real time – no (default value)

Application of real-time data correction precludes post-processing with some systems.  In order to guarantee the ability to post-process the collected values, real time data correction should always be set to NO.  If the individual GPS unit allows processing of real-time corrected data, Apply real-time may be set to YES.

9.  Height – (height of antenna)  (use 1.5 m)

Because only horizontal positions are being used to determine shoreline position, vertical elevations are not relevant.  However, an approximate elevation should be entered to avoid complications in position calculations.


10. Coordinate System – UTM 18North, or 19North for CACO only

The Coordinate System Zone identifies the reference system on which the geographical data will be projected.  

11. Datum – North American Datum 1983 (NAD83)

The Datum refers to mathematical model of the surface of the earth on which a mapping and coordinate system is based.  

The following are complete listings of settings for a Trimble GeoXT using either 1.) the GPScorrect extension in the ESRI ArcPad software or 2.) TerraSync software for data collection.  

II. GeoXT Operation and Navigation (ArcPad example):
 

Powering On/Off: 


Press the power button [image: image22.png]


 at the bottom center of the unit.

Note: Connection of the receiver to the datalogger may power on the system automatically and drain the batteries. 
Navigating the menus: 
On a unit using ArcPad and the WindowsCE operating system, a stylus is used in much the same manner as a mouse on a desktop or laptop computer.  Progams are opened by navigating to them on the Start menu or double clicking a shortcut icon on the desktop.

In ArcPad, common tasks are represented by icons along the toolbars docked at the top of the screen.  Further menu options are available by clicking the down arrows [image: image23.bmp] immediately to the right of those icons.


Configuration Settings for GPS shoreline position collection


It is important that each of the following settings is configured.  Whereas some of the settings are not used or not required, they must be entered to ensure there are no inconsistencies in the setup.  Items bolded and underlined in the submenus below indicate values to be entered.  Items that directly affect the quality of GPS positions and position collection are further elaborated.  

GPScorrect settings


1.  Accessing GPScontroller menus

a. Power on the GeoXT GPS unit and open the ArcPad program
b. Access the GPScorrect extension by clicking the Trimble icon[image: image24.png]


.

c. Click the down arrow on the main menu and choose Setup.

2.  Logging settings

a. Click on Logging Settings

b. Log GPS to SSF = On
c. Data type = SuperCorrect
d. Click OK

3.  GPS settings

a. Make sure checkbox in upper left is un-checked

b. DOP type = PDOP
c. Max PDOP = 6.0
d. Min SNR = 5.0
e. Min Elevation = 15°
f. Velocity Filter = Off
g. Click OK


4.  Real-time settings

a. Choice 1 = Integrated WAAS
b. Choice 2 = Use Uncorrected GPS
c. Real-time Age Limit = 25 s
ArcPad settings


1.  Accessing the settings menus

a. Power on the GeoXT GPS unit and open the ArcPad program
b. Access the Options dialog box by clicking the Tools icon [image: image25.png]


 on the main toolbar.


2.  Protocol settings

a. Click on the Protocol tab

b. Uncheck “Automatically Activate”

c. GPS Datum = D_North_American_1983 CSRS98
d. Check “Use Height in Datum Transform”


2.  GPS settings

a. Click on the GPS tab

b. Port = COM3
c. Baud = 9600
d. Parity = Odd
e. RTS Control = enable
f. DTR Control = enable
g. Data Bits = 8
h. Stop Bits = 1
i. Check “Show GPS Activity in System Tray”

j. Leave remaining boxes unchecked
3.  Quality settings

a. Click on the Quality tab

b. Check “Non-compulsory Warnings”

c. Check Maximum PDOP = 6
d. Check Minimum EPE = 12
e. Leave remaining boxes unchecked

3.  Capture settings

a. Click on the Capture tab

b. Check “Enable Averaging”

c. Points = 12
d. Vertices = 12
e. Streaming Vertices Interval = 1
4.  Alerts settings

a. Click on the Alerts tab

b. Check all boxes

The remaining settings generally apply to display preferences and may be changed as the user sees fit.  

III. GeoXT Operation and Navigation (TerraSync example)

1.  
Power on the unit, and click Start → Programs → TerraSync.


2.
The figure that appears is a current satellite map with two drop-down boxes on upper left.  Choose the uppermost box to reveal the main menu options.  Choose SETUP.
3. 
Review CURRENT CONFIGURATION.  Changes are to be made in the following categories (accept default in all other selection options):

a.  LOGGING SETTINGS 

i.
Log Velocity Data:  No

ii.
Log SuperCorrect Data:  Yes

iii.
Log QA/QC Data:  No

iv.
Antenna Height:  1.5m

v.
Allow Position Update:  Confirm

vi.
Confirm End Feature:  Yes

vii.
Between Feature Logging, Interval: Off  

b.  GPS SETTINGS
i. DOP Type:  PDOP 

ii. Max PDOP:  6.0

iii. Min SNR:  4.0

iv. Min Elevation:  15°

c.  COORDINATE SYSTEM

i. System:  UTM 

ii. Zone: 18 North

iii. Datum:  NAD 1983 (Conus)

iv. Coordinate Units:  Meters

d.   UNITS

i. Distance Units: Meters

ii. Area Units: Square Meters

4.  Return to the SETUP menu

5.  In the drop-down menu at upper left on screen, choose DATA.  The ‘Create New Data File’ screen should appear.  If not, select New from the drop-down menu below DATA.

a.  File Type:  Rover

b.  File Name:  <park code>_<MMDDYY> (e.g., FIIS_101807)

c.  Dictionary Name: Generic

6.  Click ‘Create’

a.  Confirm Antenna Height of 1.5 m.

b.  A new rover file is created showing the Park name and date.

c.  Under Choose Feature, select Line_generic

d.  Click [image: image26.png]


, and choose Logging Interval... Set the interval for 1 second (the default is 5 seconds).  Click ‘OK’.  

e.  Click [image: image27.png]


 again, and choose Log Later.  (This will delay the start of the survey until you are ready to collect data).  

f.  Under Choose Feature, make sure Line_generic is still selected.

g.  Click [image: image28.jpg]eate



.  

You are now ready to initiate the logging sequence.  You may begin logging by pressing the [image: image29.png]Log




 button, or close the file by choosing CANCEL.  The process of completing the survey of shoreline position is described in SOP #6 – Conducting the GPS shoreline survey
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The objective of this SOP is to detail the procedure for identifying and systematically recording the position of the shoreline. To reduce the effects of short-term variations in shoreline position, the optimal shoreline would be collected during a period of low tidal range (neap-tide) and during non-stormy conditions (SOP #4). Therefore, the target shoreline, for the purposes of this protocol, is the neap high-tide swash line (Figure S6.1).  It is a representative qualitative feature that identifies a water/land surface intercept (a shoreline).  It is easily collected using existing equipment, it is feasible to implement on the network level, and its collection as a dataset allows it to be compared to archives of historical shoreline positions.  
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Figure S6.1. Conceptual dune-beach profile showing the juxtaposition of water level, topographic features, and the identification of the neap high-tide swash line.  


A preliminary part of the monitoring program is the selection of a shoreline survey window using the procedure in SOP #4 – Mission Planning.  Unless constrained by a storm event or very high spring tides, the survey is scheduled for the first convenient high-tide in mid-March to late April (spring survey) and mid-September to late October (fall survey).  The shoreline data collection will begin one to two hours after high tide to allow sufficient time for the water level to recede.  This will expose sufficient beach face for collection to be possible and leave a clearly identifiable swash mark.


This SOP consists of four components.  The first component is the initial preparation procedures that include the visual identification of the line, initialization of the data form, and collection of the optional benchmarks.  The second component is the survey of the shoreline with the GPS.  The third component deals with natural or artificial perturbations to the shoreline, including natural features (e.g., cusps, scarps), hard structures (e.g., groins, jetties), and human interference (e.g.,anglers).  The fourth component ends the survey and records the position of any final benchmark.

Component 1 - Preparatory Procedures:  


Before beginning data collection, go to the beach and visually confirm that the swash line is identifiable and on the beach face.  The line may be a damp sand and shell hash line, a debris line, or some combination of these characteristics (Figure S6.2).  The swash line’s presence on the beach face assures that no unusual wave or water levels were present.  If the swash line is landward of the berm crest it is likely that the surge and tides that created this line exceeded the threshold for a low tide and/or non-stormy conditions.  Therefore, the survey must be rescheduled using the procedures described in SOP #4 – Mission Planning. 


[image: image31.jpg]



Figure S6.2. This high-tide swash line (dashed red line), on the beach face, is composed of the upper limit of damp sand, shell hash, and small amounts of debris.  


There may be more than one shell hash/debris line on the beach face.  The more recently-deposited high-tide swash lines are more distinctive than older, more muted lines (Figure S6.3).  Less distinct lines will also be deposited as the tide recedes (Figure S6.3).  It is essential to survey the most recent-and-highest of the shell hash lines on the beach face.

[image: image32.jpg]



Figure S6.3.  This recent high-tide swash line (dashed red line) is a damp sand and shell hash line with debris.  There are older more muted lines landward and there are lower lines seaward.

Initiate the Field Data Form

The Field Data Form (FDF) is used for all field notations.  This information is necessary for post-processing of the data and facilitates the generation of accurate metadata.  Once the shoreline has been visually identified on the beach face, fill in all fields (except for End time) in the “Event Information” and “GPS Device / Settings” sections of the FDF using the following formats. 


1. Date (mm/dd/yyyy) - Write the date in the format shown.  Include the forward slash.  Examples are 05/05/2005 and 12/31/2005.


2. Park Unit – The 4 character park identifier, CACO, ASIS, GATE, FIIS, and the unit if applicable.  For example, ASIS or GATE-SHU.

3. Observers Name (First Middle Last) – Write the surveyor’s full name.

4. Protocol/SOP Version (GMP version #/SOP version #) – Version of the protocol used to guide field data collection. Example is GMP v1.0/SOP#6 v1.1

5. Date of last storm event – This information should have been gathered during mission planning (see SOP#4).


Many of these initial values may be entered prior to going into the field.  Additional items on the FDF (e.g., Start Time, End time, Survey Notes, Download options) will be logged later in the survey or can be derived from the GPS file in the post-processing phase. Any notes regarding equipment problems, obstacles encountered, etc., should be logged in the Survey Notes section, and the time from the GPS unit noted.  Either the FDF or the comment/note function of the datalogger will be used to record observations and notes during the survey.  If stored on the GPS unit, a copy of all comments should be attached to the FDF (either digitally or with a hard copy) prior to submitting all data products to the NCBN Project Manager.


[image: image33.emf]
Figure S6.4. Example of entries on the Field Data Form.
Incorporating Benchmarks into the Survey


All GPS positions are independent data points, and collecting reference locations (benchmarks) at a variety of locations and times can help to verify the continued precision of the GPS measurements of the shoreline position.  Benchmarks can serve as high quality reference points and can be collected when available as a check for accuracy both during and following the survey.


To collect a reference point, position the GPS antenna directly over the benchmark and begin point feature collection.  The GPS records the position of the antenna, so do not begin collection until the antenna is directly over the feature to be recorded.  Store the benchmark and log the benchmark information on the FDF or make comments in the datalogger.  Be sure to include the following information in the notes:

1. time and point number of each benchmark recorded, as displayed on the GPS datalogger
2. the unique benchmark identifier stamped on the benchmark
3. the condition of the benchmark, especially if the condition is degraded or questionable

Component 2 - Shoreline Survey Procedure

Beginning the Survey

Mount the GPS antenna on the quad or 4x4 vehicle.  Position the vehicle at the starting point for the shoreline collection.  Place the antenna between the observer’s position and a front tire (or over the driver’s side tire on a 4x4 vehicle) to make it easier for the operator to accurately drive the shoreline.  Regardless of the placement of the antenna on the vehicle, the GPS always records the position of the antenna.  Once the antenna is directly over the shoreline, collection can begin.  Make a note on the FDF of the starting point number and time, or obtain this information from the GPS file after the survey. 


Anytime data collection is started, stopped, or paused, a note should be made on the Field Data Form or in the datalogger.  Notes should be as detailed as possible, and must include point numbers (if applicable) and detailed descriptions.  These notes are crucial in the QA/QC procedure and are the only documentation for decisions made in the field. Do not use abbreviations in note taking.  

To begin data collection

1. Open the pre-configured GPS file and pause the datalogger

2. Position the antenna over the beginning of the shoreline

3. Unpause logging to start the datalogger and begin collecting the line feature 

4. Ensure that the positions are being collected by observing the point count increasing and/or hearing the audible clicks (depending on one’s unit / settings)..  

5. Once logging is verified, proceed to drive the shoreline at approximately 10 mph, maintaining the antenna’s position over the high-tide swash line.  

Following the Shoreline


The natural shape of the shoreline may be linear, it may be cuspate (scalloped), or there may be broad sweeping curvilinear forms in the beach (Figure S6.5).  These configurations may be indicative of a change in processes and are important to the shoreline collection. Make every effort possible to maintain antenna position over the high-tide swash line while following these features.  

[image: image34.jpg]



Figure S6.5.  Example of a cuspate shoreline where the high-tide swash line tracks the shape of the cusps.  Cusp dimensions are approximately 10-15 meters alongshore and the swash line should be followed as part of the shoreline survey. 


If the features are very small (on the order of a few meters), driving the line will naturally average these features because it would be impractical to position the antenna to follow every nuance of the line (Figure S6.6).  The dashed line in Figure S6.6 shows the path that should be taken in surveying the very irregular swash line on a nearly linear beach face.  These small-dimensioned irregularities are related to the micro-topography of the beach and are therefore representative of short-term conditions, rather than long term (seasonal and longer) trends.  Large dimension cusps, on the order of 50 meters or greater, may be indicative of sediment budget processes that are representative of trends of seasonal and annual time scales, and therefore their location should be recorded.  Cusps on the scale of 10s of meters should be followed wherever possible. 

[image: image35.jpg]



Figure S6.6.  The high-tide swash line (red dashed line) has small irregularities that will be smoothened, recording the average position of the line. 

Verification of the Survey


Every 15-20 minutes, stop driving and verify that points are still being collected, and visually note the location.  Verification of the data logger’s functionality reduces the potential loss of data.  If points are no longer being collected, rectify the problem and return to the previous stopping point and resume shoreline collection.  These brief stops provide an opportunity to survey supplemental benchmarks if they are available and nearby.  Anytime logging is stopped and restarted a note should be made on the Field Data Form or in the datalogger.  

During the stop:

1. Confirm points are still being collected


a. If points are being collected, continue survey

b. If points are not being collected, rectify problem, and return to last known recorded point location and resume shoreline survey.

2. (Optional) If a benchmark is nearby and convenient, record the position of the benchmark as a point feature 

3. (Optional) End and store the line feature, and start a new line feature in the same GPS file. Any time the survey is stopped there is an opportunity to store the feature to help prevent loss of data.  
Component 3 - Interruption Procedure
Interruptions to the Shoreline Survey


During the survey, a variety of landforms and obstacles will be encountered.  Natural landforms such as scarps or cliffs may either temporarily impede the collection of the line, cause a break in the line (where the line has to be paused and restarted after the obstacle is passed), or cause a different collection method to be used (such as walking the shoreline).  The shoreline may also be physically interrupted by artificial structures (groins, jetties, seawalls).  Additionally, shoreline collection may be interrupted by human obstacles (anglers, bathers).  Any time the survey is interrupted (the line is stopped, a supplemental benchmark is recorded, an obstacle is avoided, or the survey deviates from the line) a note must be made on the Field Data Form or in the datalogger.


The shoreline, in some places, may be difficult to survey with a vehicle because the beach may become excessively steep, it may be very narrow, or there may be restricted access.  As an example, the swash line may be at the base of a steep scarp.  In this case, a notation may be “Significant scarp in the beach face.  Swash line at the base of the scarp.  GPS location recorded 1 meter east of scarp, on foot, beginning at point 1100 and ending at point 1700 (approximately 750 meters)”.  If the shoreline needs to be walked for any reason, follow this procedure:

1. While still on the shoreline, pause the data logger.

2. Make a note on the Field Data Form of the Time, Point Number, and the reason for the interruption of the line.

3. Remove the GPS unit (including antenna and datalogger if not internal) from the vehicle.

4. (Optional) The logging interval may be changed to one point every five seconds 

5. Position the antenna over the swash line.  Vertical height above the line does not matter, only horizontal position.

6. Resume data logging.  

7. Walk the shoreline, recording the swash line location.

8. Continue walking until the shoreline can be reoccupied using a vehicle.

9. Pause logging on the GPS datalogger.

10. If a benchmark is in the area, take the opportunity to survey it at this time, making notes as necessary

11. Return to the vehicle with the GPS paused, remount the GPS, reset the logging interval to one second (if necessary) and drive to the last recorded point.

12. Make a note on the Field Data Form of Time, Point Number, and make a note stating the line is being continued. 

13. Resume logging; visually observe that data are being collected

14. Continue driving the shoreline. 

a. Hard Structures –Physical obstacles may impede the collection of a continuous shoreline.  In this case, the data logger must be paused so that only the dynamic sandy portion of the shoreline is collected.  This will guarantee that the shoreline collected is comparable to other datasets and prevents the need for portions of the shoreline to be interpreted differently.  If the static structure at the shoreline is collected, the feature must be coded separately or collected as a separate feature to ensure it is not misinterpreted. Make detailed and specific field notes on the data sheet to aid subsequent processing, editing, and metadata notations.  If the structure causes an offset in the shoreline, such as the displacement of the shoreline on the updrift and downdrift sides of a groin (Figure S6.7), pause and store the line feature, go around the obstacle, and start a new line feature (in the same file) once the antenna has been repositioned over the shoreline.  Anytime the GPS is removed from the vehicle there is an opportunity to add a supplemental benchmark.
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Figure S6.7.  This aerial view of GATE-SHU demonstrates the offset of the shoreline at an interruption. Source: NPS-GATE


b. Anglers – Anglers tend to congregate near the high-tide swash line.  Their fishing lines and equipment can create a hazard to a surveyor in a quad or vehicle.  Also, GPS equipment can cut or break fishing lines.  If anglers are encountered, there are two options.  

Option 1) If there is a small group or an individual angler:



1. Pause the GPS line feature



2. Go around the obstacle



3. Reposition the antenna over the shoreline



4. Unpause the line feature



5. Verify logging



6. Resume driving the shoreline, 

Option 2) If pausing the line feature is inconvenient or impossible, 



1. Make a right angle (90 degree) turn landward



2. Travel inland far enough to avoid the obstruction



3. Make a right angle turn and travel past the obstacle



4. Make a pair of right angle turns and return to the shoreline.



5. Once past the obstruction, stop and make a note on either the FDF or the 

    datalogger to alert the data processor of the deviation.

Component 4 - Completion of the Survey 

Completion

After the spatial extent of the shoreline survey is completed, pause and store the line and collect the end of survey benchmark.  

1. Pause and store the survey shoreline while stopped on the swash line.

2. Make a note on the Field Data Form of the End Time (if making all notes on the FDF).  Use the time displayed on the GPS receiver, not off a watch.  24-hour (military) time should be used, in local standard time.  For example, 0800 and 1350 for 8am and 1:50pm, local time, respectively.
3. Store the line feature

4. Optional - Drive to the nearest or most convenient benchmark

5. Remove the GPS from the vehicle.

6. Position the GPS antenna over the benchmark.  

7. Create a new point feature

8. Once at least 12 positions have been recorded, store the point feature.

9. Record the position of the final benchmark and log the information on the Field Data Form.

10. Turn off data logger 
Upon return to the office, download the data and make a backup copy (SOP #7). If the data are not downloaded immediately there is a chance they could be lost due to an equipment malfunction.  
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Summary: 


The objective of this protocol is to convert the collected shoreline position data into a useable dataset that is in the correct format and has undergone initial quality control (QA/QC) checks.  Quality control checks ensure that the data collected are of the maximum quality possible.  Download and QA/QC of the survey data are to occur immediately following the field data collection to ensure that no data are lost due to equipment failure. In addition, prompt data processing immediately informs the surveyor if a repeat survey day is required due to equipment issues. 


This protocol summarizes the data download procedures and initial quality control steps necessary for accurate and systematic processing.  It demonstrates how to connect the Trimble GeoXT datalogger to a computer running Pathfinder Office software (for example), how to perform initial quality checks, and how to set up appropriate output specifications. It describes the process for converting the evaluated point shapefile into a single shoreline feature (polyline shapefile); generating FGDC-compliant metadata for that polyline file; and assembling all original, corrected, and processed data products for delivery to the NCBN for storage and analysis.
Connection of the datalogger to the computer for survey transfer.

Data collected in the field should be transferred to a PC for backup as soon as possible after the survey.  The data should not be left in the datalogger overnight without first downloading.  Even after the data are transferred, do not delete the data file until confirmed backups have been made.

1.
Connect Datalogger to PC using a USB or serial data cable, or using a Bluetooth connection.  

2.
Power on the GeoXT.

3.
On the PC, open the Trimble Pathfinder Office software.

4.
In the Select Project dialog box that appears, select ‘New…’

a.
Project name: Park Code _ Season _ 4-digit Year (e.g. FIIS_FALL_2007).

b.
Comment:  Adjust to match the survey date and start time.

c.
The project folder and sub-folders may be left as the default setting or changed to a custom location on the PC as desired.

5.
Click ‘OK’ twice.

6.
Select Utilities → Data Transfer.  The software should automatically connect to the datalogger.  If the software does not automatically connect, check the cable connections and port settings under “Device,” and click the ‘Connect’ button  .

7.
Click ‘Add’ → Data File, and browse to the file(s) to transfer.  

8.
Click ‘Transfer All’.  

9.
Click ‘Close’.

The transferred files will be in “.ssf” format.  If using a computer which has a version of Microsoft ActiveSync installed (http://www.microsoft.com/windowsmobile/activesync/default.mspx), a connection to the GeoXT may be automatically established upon plugging the datalogger into the machine.  In this case, the .ssf file can be directly dragged-and-dropped from the GeoXT onto the computer’s hard drive.  Note: if the shoreline survey data were collected using a shapefile uploaded to the GeoXT, be sure to also transfer that file along with the .ssf file.
Differential Correction of the Shoreline Survey (unless accomplished in real-time collection with Beacon)


The raw data downloaded in steps 1-4 of this SOP need to be differentially corrected to reach the maximum accuracy possible for the Trimble GeoXT equipment.  The process of differential correction compares the records received at one or more local known GPS base stations to those received in the field.  The closer the reference station(s) location is to the survey site, the more accurate the differential correction.  

1 
In Pathfinder Office, choose Utilities → Differential Correction.  

2.
Browse and select the recently downloaded “.ssf” file(s).  

3.
Click ‘Internet Search’

4.
Click ‘New…’

5.
Select “Copy the most up-to-date list…” and click ‘OK’.

6.
Select a provider from the list.  Closer base stations are listed first (e.g., Central Islip, NY), and are generally recommended.

7.
Click ‘OK’ through a series of dialog boxes until the files have been downloaded and are visible in the Base Files section of the original Differential Correction dialog box.

8.
Select “Smart Code and Carrier Phase Processing,” and Click ‘OK’.  This will begin the differential correction of the GPS positions and saves a file with the extension “.cor.”  

9.
A log file will also be saved with the “.cor” file detailing the differential correction process and any errors that have occurred.  Typically, 100% of the points will be corrected.  If some points remain uncorrected, try processing with an alternate station by repeating the steps above.  If after several attempts using different base files, a large contiguous block of points remains uncorrected, that section of the shoreline may have to be re-surveyed on the following day.
Data Export


Once the data have been downloaded, differentially corrected, and passed through initial QA/QC, they should be backed up.  Making duplicate copies of the data should be a standard practice to prevent problems associated with loss of files and possible data corruption.
1. With the “.cor” file open, choose “Export” under the Utilities menu.  

2. Choose an output folder or select the default folder.

3. Choose “Sample ArcView Shapefile Setup” from the drop-down menu.

4. Select “Change Setup Options” and choose the following settings from each of the tabs:

a. Select Properties 

i. Data

1. Features – Positions and Attributes – selected

a. Export all Features

2. Notes – checked

3. Velocity Records – unchecked

4. Sensor Records - unchecked

ii. Output    

1. Select “Combine all input files and output to the project export folder” 

2. Select DOS files

iii. Attributes – Export Menu Attributes As – Select “Attribute Value”

1. All Feature Types – select ONLY

a. PDOP

b. Date Recorded

c. Time Recorded

2. Point Features – select ONLY

a. Position

b. Horizontal Precision

3. Line Features – select ONLY

a. Length (2d)

b. Avg Horizontal Precision

4. Area Features – select NONE

iv. Units – 

1. Use Export Units – select:

a. Meters

b. Square Meters

c. Meters per second

2. Decimal Places

a. Lat/Long – 9

b. North/east – 3

c. Height – 3

d. Distance – 3

e. Area – 3

f. Velocity – 3

g. Precision – 1

h. Time - 0

v. Position Filter – Select Filter by GPS Position Info

1. Minimum Satellites – 2D (four or more SVs)

2. Maximum PDOP (any)

3. Maximum HDOP (any)

4. Include positions that are – select ONLY

a. Realtime Differential

b. Differential

c. RTK (fixed)

d. Phase Processed (fixed)

vi. Coordinate System – UTM 18 North/19 North (CACO Only)

vii. Arcview Shapefile – select NONE

5. As an alternative to step 4, choose “New Setup” and use the above settings.  This option will allow the user to save a template for export settings.

6. Select “Okay” and the data will be exported, along with a text log file.

7. Copy the exported data, along with the original “.ssf”, the initial “.cor”, any supporting text log files, and an image scan of the Field Data Form, to an external media (CD or floppy) so that there are separate backup locations (one on the hard disk drive and one on the removable media).  Place all files in a folder labeled with the survey location and time.

Once the data have been exported and backed up, verify that the backups exist in various locations, including the PC and a least one type of removable media.  This guarantees that duplicate copies of the raw and corrected files exist.  Once the duplicate copies are verified, the data may be deleted from the datalogger.

Initial QA/QC

QA/QC (Quality Assurance/Quality Control) is a verification step that ensures the data collected have had obvious errors removed and that the remaining data are likely to accurately represent the shoreline.  Verification of the three (or more) known benchmarks embedded in the survey adds further credence to the collected shoreline positions.

1. Using GIS software such as ESRI ArcGIS, open the “.shp” file exported above. 
2. Add current orthophotography and other available base data to the view.
3. During this procedure the surveyor should be present, along with the notes on the Field Data Form.  Visually compare the expected feature locations with the recorded locations.  If any features are obvious errors should be corrected.
4. Optional:  compare any known benchmarks (points) collected with their known values.    If the difference between the recorded position and its known value is greater than one meter, the shoreline may need to be re-surveyed.
Generating the Shoreline Line Shapefile from a Point Shapefile
The utilization of some combinations of GPS units and software may necessitate the shoreline being collected as a point dataset rather than a line.  In such a case, once the “cleaned” point shapefile has been exported, it must be converted into a continuous line feature in order to be analyzed by shoreline-change analysis software (see SOP #8).  This general procedure can be accomplished using any number of GIS software packages capable of rendering and editing shapefiles.  The following steps describe the process of  generating a line feature from a point shapefile using ESRI ArcMap software, the most common product used by NPS GIS personnel.  

1. If for some reason x and y coordinates are not present in the point shapefile’s attribute table, use the “Add XY Coordinates” tool to create these fields, or use the “addxy_management” command at the command line.

2. Open the attribute table of the point shapefile.

3. Under ‘Options’ choose ‘Export’; save the attribute table as a dbf file.

4. Using Microsoft Excel, Word, or another spreadsheet or word processing program, generate a text file in which each point is represented with a line of text in the following format:  ID number, x-coordinate, y-coordinate.  The last line should simply contain the word “end.”
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5. Save the file with the extension “.gen” (e.g., points.gen).

6. Use the “Generate” tool in ArcMap to create the line shapefile.  

7. View both the point and line shapefiles together in ArcMap to assure that the conversion completed successfully*.

* Alternatively, there are many free ArcMap extensions capable of converting point shapefiles into line features with a single step.  An excellent example is the Convert Locations To Paths tool found in the HawthsTools suite (http://www.spatialecology.com/htools/tooldesc.php).

Creating Metadata for the Shoreline Shapefile

The NCBN has created a metadata template for the Shoreline Change Protocol that already contains much of the relevant information regarding creation of the line shapefile.  Most of the remaining information to be included will be derived directly from the field sheet completed prior-to and during the data collection process.  Table S7.1 summarizes where this information should be included in the metadata file.  At a minimum, the metadata should be parsed and exported in XML format using the NPS Metadata Tools available at http://www.nature.nps.gov/im/units/mwr/gis/ .

	Field form data
	Metadata tag

	Park Unit
	Abstract

Keywords

	GPS unit Make and Model
	Process step, Process description

	Expected Accuracy with differential correction
	Positional accuracy, Horizontal positional accuracy, Horizontal positional accuracy report

	GPS Unit Settings
	Positional accuracy, Horizontal positional accuracy, Horizontal positional accuracy report

	Who processed the data
	Process step, Process contact

	Software used to download, post-process data;  Base station(s) used; description of any data editing
	Process step, Process description


Table S7.1.  Organizational comparison of field data and metadata files.

Final Product Delivery
The following raw data products should be delivered to the NCBN Data Manager for storage, analysis, and archiving in the Shoreline Change Database:


· All original GPS data files (.ssf) downloaded from the GPS unit

· All differentially corrected GPS data files (.cor), if real-time correction was not employed

· Cleaned, exported ESRI point shapefile (.shp; if applicable)

· Cleaned, continuous shoreline line shapefile (.shp)

· Metadata for the above line shapefile.

· Hard- or scanned copies of all field sheets.

These items should be emailed to the Data Manager (see website for address: http://www.nature.nps.gov/im/units/ncbn/), or saved to disc and mailed to:

Northeast Coastal & Barrier Network

Data Manager

URI Dept. of Natural Resources Science

1 Greenhouse Rd.

Kingston, RI 02881

Standard Operating Procedure (SOP) # 8 – Change Calculation, Data Analysis, and Reporting

Version 1.0 (July, 2007)

The following table lists all changes that have been made to this Standard Operating Procedure since the original publication date.  Any recommended or required changes added to the log must be complete and concise and promptly brought to the attention of the Project Leader.  The project leader will review and incorporate all changes, officially complete the revision history log, and change the date and version number on the title page.  For complete instructions, please refer to Section II of SOP#10 – Revising the Protocol. 

Revision History Log:

	New Version #
	Previous Version #
	Revision Date
	Author (full name, title, affiliation)
	Location in Document and Description of Change
	Reason for Change

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


I. Summary

The comparison of GPS shoreline positions and the quantification of their differences requires that each GPS shoreline survey be transformed into a continuous line feature from which distances to a pre-established offshore baseline are made.  Distances from each GPS shoreline feature to the baseline are measured using pre-established transects at regular intervals.  The results of these comparisons are then entered into a distance matrix. Creation of the data matrix provides the means to characterize the entire shoreline (as a whole) as well as subsets of the shoreline (smaller areas of interest).  This SOP identifies the Digital Shoreline Analysis System as the recommended tool for measuring and reporting the changes in shoreline position. 
  Additionally, this SOP describes a suite of summary statistics and trend analyses that can be used in describing and comparing the spatial measures of change.  It concludes with an organization structure for the Annual Report and the Project Term Report.  

II. Objectives of this SOP


Unlike the previous SOPs that describe an activity to be accomplished as a means to collect, download, and transmit the collected shoreline position data, this SOP describes the approach that is used to transform the shoreline survey polyline into a suite of measurements that comprise a data matrix that serves as the basis for subsequent calculations of dimensions of change.  The transformation is conducted by the Project Leader rather than the field investigator and the output is shared within the Park and within the Northeast Coastal & Barrier Network. This SOP therefore, in part, provides information and contributes to an understanding regarding the generation of the matrix of measurements of shoreline change and the format of the data output.  Further, this SOP presents a series of guidelines that describe the composition of the data portrayal and analysis to be used in the production of the Annual Report and in the Project Term Report.

III.  Procedural Background Steps 

The procedures described in this SOP utilize a program developed by the United States Geological Survey entitled Digital Shoreline Analysis System (DSAS) that has been developed to measure, calculate, and statistically analyze changes in shoreline position (Theiler, et al, 2005). DSAS is an open source extension to ESRI ArcMap 9.x software.  The latest version, along with installation instructions, a detailed user’s manual, and additional background information can be found at: http://woodshole.er.usgs.gov/project-pages/dsas/ .  A copy of Version 3.2 of the DSAS User’s Manual is also included as Appendix B.
The basic concept underlying the comparison of the GPS shoreline positions and quantification of their differences within the DSAS program is that a series of preliminary steps are required to enable the calculation of shoreline change.  These steps incorporate the development of a trendline (a general shoreline), a corresponding offshore baseline, and the generation of equally-spaced transects extending inland from the offshore baseline.  After these line products are created (they are generated once for each park), they are used in the processing of each GPS shoreline.   The following section describes the steps by which the DSAS requirements of a Shoreline Trendline, Baseline, and Transects are generated.  




a. Creation of the Trendline and the Baseline

The Trendline represents the general trend of the shoreline (Fig. S8.1) as determined using current orthophotography for each Park.  It is created by drawing a smoothed line along the entire length of the ocean beach shoreline as defined in SOP #3.  The Trendline is digitized using ESRI ArcMap software and saved as a geodatabase polyline feature as specified in Sections 6 & 7 of the DSAS User Guide (Appendix B).   The Trendline is used to generate the offshore Baseline from which distances to the surveyed GPS shorelines are measured.  The Baseline is developed by re-creating the Trendline approximately 200 meters seaward and parallel to the smoothed shoreline (Fig. S8.2) using the buffer function in ArcMap.  This creation of an offset reference for subsequent comparison is necessary so that future positions of the eroding or accreting shoreline will not intercept the Baseline and thereby complicate the mathematical calculations.  The Trendline and Baseline are created once for each park, and will only need to be modified if they no longer represent the general trend of the shoreline; for example, if there is a major (catastrophic) change. The Trendline and the Baseline are retained in the Geodatabase for each Park (Appendix A, Database User’s Guide, Section 3.1).
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Figure S8.1.  The Trendline is a smoothed representation of the general trend of the shoreline that removes the minor features caused by local conditions (this example is a part of the Fire Island National Seashore).  


b. Creation of Transects
Once the Baseline is created, transects are generated using the DSAS toolbar in ArcMap.  The process for creating these transects is demonstrated in the user guide, sections 11-18, available on the DSAS website (http://woodshole.er.usgs.gov/project-pages/dsas/version3/index.html) or Appendix B.  Details of how to correctly format files for import and use in the DSAS extension are also provided in the DSAS tutorial and user guide.  Additionally, the DSAS website provides a sample data set to be used as a model.  The DSAS software allows the user to generate transects at equally spaced locations (10 m in this case) originating at the Baseline.  These initial transects are created automatically in DSAS and may be subsequently adjusted using DSAS and ArcGIS so that they intersect the Trendline at approximately 10m intervals and are all approximately perpendicular to the Trendline (Figure S8.3).  These transects are used in DSAS to measure distances between each GPS-measured shoreline and the Baseline. The even spacing of transects along the Trendline supports the unbiased and systematic calculations of descriptive summary statistics, such as the mean value and the standard deviation of shoreline change as well as trends in change over time. 

c. Adjustment of Transects

Transects crossing relatively straight sections of shoreline need little if any adjustment.  However transects crossing the Trendline in more curvilinear sections will need to be adjusted, e.g. added, deleted, or moved, so that all transects intersect the Trendline perpendicularly at roughly 10 m intervals (Figures S8.4a-b).  These adjustments can be accomplished using the smoothing function routine when casting transects in DSAS and/or utilizing the feature editing capabilities of GIS software packages such as ArcMap.
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Figure S8.2. The Baseline is positioned 200 m offshore, parallel to the Trendline.  
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Figure S8.3.  The yellow lines originating at the Baseline are the transects created by DSAS that will be used to measure distances from the Baseline to the surveyed shoreline position at each of the intercepts.
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Figures S8.4a-b.  Example of transects created automatically by DSAS for a curved portion of the Sandy Hook shoreline (left panel) and those same transects after manual adjustment (right panel).  Transects are shown in yellow in both panels.  

In summary, the steps required to generate measurements of shoreline change and subsequent analyses of these changes consist of:

1. Producing a smoothed shoreline (Trendline) and an offshore Baseline 

2. Creating a series of evenly-spaced transects originating from the offshore Baseline in DSAS
3. Adjustment of transects using DSAS and/or ArcGIS so that each transect intersects the Trendline perpendicularly at approximate 10m intervals 

The most current versions of the Baseline and transects reside as line feature classes in a Geodatabase for each park, which is maintained by the NCBN Data Manager. 
IV.  Collection and Storage of the Shoreline Survey
1. Continuous Shoreline Creation

Depending on the equipment and settings used, the initial survey of the GPS shoreline position produces either a continuous line feature or a dataset consisting of a series of points spaced 5-10 meters apart.  If the latter is the case, then the GPS shoreline data must be transformed into a continuous line feature in order to generate comparative distance measurements and summary statistics of the entire ocean shoreline (Figure S8.5).  Procedures for converting a point dataset to a continuous line dataset are presented in SOP#7.  

Once created, the new shoreline polyline shapefile will be exported and saved to the appropriate park’s geodatabase and a record will be added into the appropriate table in the protocol database (See SOP#9). 
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Figure S8.5. Example of GPS Shoreline used for measuring distance from the Baseline to the survey line. The shoreline survey consists of the blue points that are connected to create a continuous line. The distance between the Baseline and this surveyed line is measured at each transect intercept (approx. every 10 meters).
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Figure S8.6. Transects are used to measure distances from the Baseline to multiple GPS-surveyed shorelines. This figure shows three shoreline positions recorded in the fall, represented by red lines, and three shoreline positions recorded in the spring, represented by blue lines.
2. Data Matrix of Shoreline Distances
Each GPS-shoreline will be used to generate a series of distance measurements from the offshore Baseline at each of the transects (Figure S8.6).  These measurements will be automatically calculated in DSAS and exported in tabular format for summary and analyses purposes.  Formatted results are shown in Table S8.1

The distance output from DSAS (Table S8.1) can be formatted so that the shoreline position data are represented by a matrix of sequential shoreline distance measurements. The product of multiple surveys will be a matrix of comparable distance values (Table S8.2). The matrix approach supports the generation of comparisons among any of the shoreline positions and requires that each shoreline be processed only once.  

	OBJECTID
	TRANSECTID
	BASELINEID
	SHORELINE DATE
	DISTANCE

	---
	---
	---
	---
	---

	---
	---
	---
	---
	---

	30
	7
	1
	4/1/2006
	217.21

	29
	7
	1
	10/3/2006
	251.84

	27
	7
	1
	4/3/2007
	233.90

	28
	7
	1
	9/31/2007
	269.99

	26
	7
	1
	3/31/2008
	241.41

	25
	7
	1
	10/1/2008
	273.02

	36
	8
	1
	4/1/2006
	218.51

	35
	8
	1
	10/3/2006
	252.37

	33
	8
	1
	4/3/2007
	233.00

	34
	8
	1
	9/31/2007
	269.55

	32
	8
	1
	3/31/2008
	242.06

	31
	8
	1
	10/1/2008
	273.46

	---
	---
	---
	---
	---

	---
	---
	---
	---
	---


Table S8.1.  A matrix of distance measurements exported from DSAS, incorporating distance measurements along Transects 7 and 8 from different survey dates. A full description of each of the columns in this table is in the DSAS User Guide and Tutorial (Himmelstoss et al., 2005; Appendix B).
	 
	 
	 
	 
	 
	 
	 

	
	Distance From Baseline (m)

	TRANSECTID
	Spring '06
	Fall '06
	Spring '07
	Fall '07
	Spring '08
	Fall '08

	---
	---
	---
	---
	---
	---
	---

	---
	---
	---
	---
	---
	---
	---

	7
	217.21
	251.84
	233.90
	269.99
	241.41
	273.02

	8
	218.51
	252.37
	233.00
	269.55
	242.06
	273.46

	9
	219.76
	252.24
	231.22
	268.28
	241.99
	272.96

	10
	220.87
	247.37
	218.88
	262.76
	238.11
	267.63

	11
	217.99
	244.15
	215.58
	260.17
	233.76
	265.82

	12
	81.48
	48.51
	72.61
	34.26
	59.54
	28.87

	13
	79.51
	51.11
	77.02
	35.58
	60.37
	31.03

	14
	215.45
	240.57
	214.00
	257.39
	231.45
	265.05

	15
	212.12
	237.49
	212.39
	255.27
	229.74
	263.67

	16
	211.36
	235.07
	210.39
	253.90
	228.72
	263.07

	17
	211.46
	233.49
	208.55
	253.14
	227.48
	262.71

	---
	---
	---
	---
	---
	---
	---

	---
	---
	---
	---
	---
	---
	---


Table S8.2.  Distance output from DSAS reformatted into Distance Matrix format

V  Quantifying Change by Comparison of Shoreline Positions
A comparison of shoreline positions is produced through a calculation of the differences in the distances from the baseline to any pair or combination of shorelines.  The result is a table of the measured alongshore displacement of the shoreline for a specific span of time (temporal variation).  These numerical data are processed further to produce summary statistics, such as a mean value of change and a standard deviation from the mean.  In addition, these temporal data may be depicted in an alongshore sequence to portray the spatial variations in shoreline positions. 



a. Temporal Comparison 
A temporal comparison is the calculation of the change in the surveyed shoreline position over some time period. Because shoreline position is surveyed twice per year, the comparison of successive shorelines reveals seasonal contrasts; a comparison of surveys conducted in the same season during successive years highlights the annual variation; and the comparison of shoreline positions surveyed over longer periods begins to reveal the trends in the direction and magnitude of change. Any change calculated from a period of more than one year, for the purposes of this SOP, is referred to as long-term change.




i. Seasonal Comparisons
The seasonal change, either winter-to-summer or summer-to-winter change for this SOP, is the difference in shoreline position between consecutively-surveyed shorelines (Table S8.3).  Generally, the summer season should be represented by a seaward displacement of the shoreline, whereas the winter season should show a landward displacement, or erosion.  Following the determination of the difference between two consecutive shorelines, summary statistics may be generated.  The mean seasonal change is the average difference in the position of the shoreline for the totality of measured points.  The standard deviation of seasonal change is a measure of the spread of difference values about the mean change calculation. Other statistical measurements may be calculated, such as median and mode, to describe and display the distributional characteristics of the dataset (Figure S8.7).
	 
	 
	 
	 

	
	Distance From Baseline (m)
	

	TRANSECTID
	Spring '06 
	Fall '06 
	Seasonal Difference 

Fall '06 minus Spring '06

	---
	---
	---
	---

	---
	---
	---
	---

	7
	217.21
	251.84
	34.64

	8
	218.51
	252.37
	33.86

	9
	219.76
	252.24
	32.48

	10
	220.87
	247.37
	26.51

	11
	217.99
	244.15
	26.16

	12
	81.48
	48.51
	-32.97

	13
	79.51
	51.11
	-28.40

	14
	215.45
	240.57
	25.12

	15
	212.12
	237.49
	25.37

	16
	211.36
	235.07
	23.70

	17
	211.46
	233.49
	22.03

	---
	---
	---
	---

	---
	---
	---
	---


Table S8.3.  An example of the comparison of differences in shoreline position between successive 

 surveys in the data matrix, from Spring 06 to Fall 06, to produce a measure of seasonal change.




ii. Annual Comparisons

The measure of annual change compares the position of the surveyed shoreline in the same season over a span of twelve months (Table S8.4). Because the seasonal variation is absent from this comparison, the change reflects the short-term balance of sediment supply (loss of sediment should produce a net inland displacement of the shoreline, whereas gain of sediment should produce a net seaward displacement).   Although the displacement does represent the positive or negative sediment budget, it may also represent the contrast in storm frequency and severity.  Thus, annual comparisons are valuable but they are short-term measures that incorporate a variety of variables.  Summary statistics, such as mean and standard deviation, should be calculated to characterize the annual changes (Figure S8.8).


Figure S8.7.  A histogram of the distribution of difference measurements comparing two consecutive shoreline positions, incorporating the mean change value (-7.6 m) and standard deviation values from the mean.  Information such as mean difference, standard deviation of difference, skewness, and other statistical descriptors may be calculated by importing the distance output from DSAS into a statistical software package.
	
	Distance From Baseline (m)
	

	TRANSECTID
	Spring '06 
	Fall '06 
	Spring '07 
	Annual Difference
Spring ’07 minus Spring ‘06 

	---
	---
	---
	---
	---

	---
	---
	---
	---
	---

	7
	217.21
	251.84
	233.90
	16.69

	8
	218.51
	252.37
	233.00
	14.49

	9
	219.76
	252.24
	231.22
	11.46

	10
	220.87
	247.37
	218.88
	-1.99

	11
	217.99
	244.15
	215.58
	-2.41

	12
	81.48
	48.51
	72.61
	-8.87

	13
	79.51
	51.11
	77.02
	-2.49

	14
	215.45
	240.57
	214.00
	-1.45

	15
	212.12
	237.49
	212.39
	0.27

	16
	211.36
	235.07
	210.39
	-0.97

	17
	211.46
	233.49
	208.55
	-2.91

	---
	---
	---
	---
	---

	---
	---
	---
	---
	---


Table S8.4.  Measurements and comparisons of differences in shoreline position between similar seasons quantify the annual change.


Figure S8.8.  A histogram of the distribution of the annual difference in shoreline position comparing two consecutive spring seasons, with mean (-8.9 m) and standard deviation values.  




iii. Long-term Comparisons

Long-term change in shoreline position is the change over any period of time greater than one year.  If only two shorelines are used to represent a long time period, they should be from the same season so that seasonal change does not bias the calculation of differences.  The use of only two shorelines separated by more than one year is referred to as an end-point calculation.  This calculation focuses on net change of shoreline position over the period of comparison (Figure S8.9).  The differences in shoreline position between these endpoints will generate a numerical array of values and thus the variety of statistical summary measures similar to those described above (mean, standard deviation) may be derived.  

Trends may also be calculated by using more than two shorelines, thus producing a series of shorter-term differences.  By comparing the sequence of difference measurements over time, the trend in the dataset may be determined.  The trend may be a simple observation of the increase or decrease in the mean difference per year (Figure S8.9). The trend could also be the calculation of the mean rate of change of the annual differences, as well as a similar comparison of the seasonal differences.  This approach identifies the internal variation in shoreline position in reaching its final location.  Any of these measures of change in shoreline position will generate a suite of numbers upon which statistical analysis may be performed to summarize the trend of the change.  Trend analysis becomes more meaningful with a longer record of shoreline change.  A minimum of five years should be used to begin to depict trends of change.

DSAS automatically provides a number of useful statistical tools for examining long-term change.  The most basic of which is the end-point rate (EPR) which is calculated by dividing the distance in shoreline movement by the time elapsed between the earliest and latest measurements (Fig. S8.9).  Whereas this value is straightforeward and only requires information about the two data endpoints, it ignores all of the intermediate data points that are also useful in describing cycles and trend in the shoreline movement behavior.  


In order to examine trends in shoreline change over time, DSAS provides estimates of the linear regression rate of change. The rate of change is the slope of the regression line fit shoreline data with distance being the response (y-variable) and time being the explanatory variable (x-variable).   In this case the estimated rate of change or slope estimated for each transect location represents the average change in shoreline location per year. 
The full list of statistical analysis tools in DSAS is listed is described in full in the DSAS User Guide and Tutorial (Himmelstoss et al., 2005; Appendix B).
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Figure S8.9.  The array of mean differences from successive GPS surveys.  Comparisons may be made of end-point positions as well as the sequence of shorter-term changes, or trends in the direction and magnitude of the changes.



b. Spatial Comparisons
Changes in the shoreline position will likely vary in both magnitude and direction along the ocean shoreline of the park.  This alongshore variation constitutes the spatial component of the comparisons in a seasonal, annual, or long-term time period. Spatial comparisons will be depicted in a map view to display the juxtaposition of the measures of change for the ocean shoreline (Figure S8.11).  These measures may be the net differences in shoreline position in an alongshore view, or the mean of the incorporated differences, or the rates of change.  In any of the portrayals of the numerical differences of shoreline position, the statistical values of mean and standard deviation may be superimposed on the alongshore plots of the data.  In long-term comparisons of changes, an alongshore plot of the frequency of exceeding one standard deviation of change during any of the shorter time intervals would emphasize areas of major change.
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Figure S8.10.  Alongshore distribution of differences in shoreline position depicting the spatial association of change, incorporating the occurrence of changes greater than one standard deviation for the data set.  The scale of change includes color as well as length of the bars for easier recognition of the comparative values.  

B. Focus on Special Areas of Interest (AOI) 
In addition to summaries of the entire shoreline, there may be areas of interest to management that would benefit from a more focused analysis.  Therefore, spatial subsets of the distance matrix may be identified to summarize change in smaller, local areas, or at specific points of interest, such as an element of infrastructure.  Areas or points of interest are to be identified by the park resource management specialist and this information conveyed to the data manager.  Subsequently, a specific measurement will be conducted at this location to document the changes within the context of the concern

The AOI will be defined as a spatial subset within the data matrix of distances.  If distance measurements are needed for a segment or region of the shoreline, the aforementioned procedures will apply.  If a single distance measurement is required and one of the evenly-spaced calculation points does not define the point of interest, a supplemental point may be calculated.  This point should not be included in mean and standard deviation summaries, because it would alter the systematic basis of the calculation.

In addition to general summary statistics, AOIs may be monitored for specific change.  Threshold values may be determined by park management or may be based on a previous analysis to signal or “flag” critical dimensions.  For example, the distance matrix may be used to identify if and when the position of a shoreline approached a minimum threshold distance to the infrastructure element.

VI. Production of Reports on Shoreline Change

There will be reports produced periodically that portray the measured changes in shoreline position in narrative, tabular, and graphical formats.  There are two types of products: an Annual Project Report and a Project Trend Report. The Annual Project Report summarizes the data from the previous year whereas the Project Trend Report covers a six-year period of time and includes information on trends and interpretations of the observations. These reports will be submitted to the park management and will also be included in the protocol geodatabase.
1. Annual Project Report

The Annual Project Report is a summary of the shoreline change data over the period of one year (three surveys).  The first shoreline position survey was conducted in the fall of 2005, therefore the first annual project report will extend from Fall 2005 through Fall 2006. General statistics (mean and standard deviation) will be included for the two seasonal changes as well as the one annual change.  In addition, spatial analysis will be conducted on each of the seasonal changes and the annual change.


The Annual Project Report is organized into sections to present the data in narrative, tabular, and graphical form.  The sections are as follows:



1. Introduction



2. Location Map




a. Baseline




b. Areas of Interest



3. Context (History of data collection)




a. Dates of shoreline survey




b. Condition relative to neap high tide



4.  History of natural and cultural events affecting shoreline position




a. Description of storm events




b. Description of steep or eroded conditions

c. Description of beach nourishment, beach scraping, or any human modifications of the shoreline




d. Description of conditions at Areas of Interest



5. Changes to the Protocols




a. Any variation in tracking the shoreline position




b. Any variation in the survey window




c. Any variation when encountering obstacles in the beach



6. Data Presentation




a. Shoreline Position (maps of the GPS shoreline survey lines)


b. Table of three calculations of distances from the Baseline points to cover the period of one year (data matrix table)



7. Calculation of Change – The distance matrix and the change matrix




This is an extension of the data matrix table

a. Calculation of differences between seasons, two columns of differences in the data matrix

b. Calculation of differences for annual change, one column in the data matrix

c. Calculation of differences at Areas of Interest


8. Descriptive Summary of Data

a. Number of points collected, maximum and minimum values, median value, of each of the three columns of data (seasonal differences and annual difference), production of histograms of data values either in this section or in section 9.

b. Presentation of data of any Areas of Interest



9. Description of General Summary Statistics

a. These are values derived from the statistical analysis of each of the three columns of data and portrayed along with a histogram for each column.  The summary statistics will include mean, standard deviation, skewness, and mode(s).  

b. Discussion of consistency or inconsistency of seasonal variation, and net change shown in the annual difference.
c.  Discussion of values in any Areas of Interest   



10  Detailed information for management

a. presentation of the spatial distribution of the shoreline changes; discussion of mean conditions and areas that are beyond one standard deviation and their relevance to resource management.  




b. discussion of areas of special interest 



11. Discussion of problems
a. Discussion of issues associated with the application of the protocol and/or any of the SOPs.

b. Discussion of concerns raised by the generation of the shoreline change information.

c.  Any changes in the shoreline trend that would affect the generation of the shoreline change measurements; this may result in revisions to the baseline feature in the Geodatabase.
2. Project Trend Report

The Project Trend Report is a summary of the full database of shorelines, with an emphasis on the previous 6 years.  It is a comprehensive complement of analyses that synthesize the shoreline change data, and provide scientific interpretation of the trends revealed in the numerical analyses. The first six sections are similar to the information described above for the Annual Report. However, the succeeding group of sections focuses on the expansion of information contained in the data    The sections are as follows:


1. Introduction


2. Location Map


3. Context (History of observations)


4. Changes to the Protocol


5.  History of natural and cultural events affecting the shoreline position


6. Complete Dataset presentation


7. Presentation of Trend analysis

a. Complete dataset, this is a graphical portrayal (scatter diagram) of the full set of annual differences for successive years (see Figure S8.9).  The data are plotted using the mean value and the accompanying standard deviation per annual period


b. Past 6 years, presented as a subset of the complete record.

8. Description of trends
a. Complete dataset, numerical analysis.  This is a presentation of the rates of shoreline change that are derived the annual record.  On the basis of end-point or other statistical analyses, an average annual rate of shoreline change will be determined. 

b. Complete dataset, histogram.  An average rate of shoreline change will be calculated and plotted for each of the baseline points, with calculations of mean and standard deviation values.

c. Complete dataset, spatial analysis.  The average rate of shoreline change for each baseline point will be presented in map form (similar to Figure S8.11).  

9. Interpretation of trends

This is to be accomplished in conjunction with an expert in coastal geomorphology, to discuss the long-term and short-term implications of the trend data on the shoreline conditions and the impact on Park resources.


10. Implications of trends on regional and national level

Also in conjunction with the expert in coastal geomorphology, place the trend data in a regional or larger context.  Shoreline change is likely to be response to variations in regional sediment supply and human manipulations to sediment budget.  


        11. Recommendations based on trends

In conjunction with coastal geomorphology expert, examine options for sediment management to buffer local effects, to redistribute sediment, to adjust topography, to manage local resources.


12. Project recommendations

As a team, review the value, continuity, and utilization of the monitoring data and the data management.  Suggest improvements for shoreline monitoring in existing protocols and other aspects for incorporation in the monitoring of coastal geomorphology.
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Standard Operating Procedure (SOP) # 9 –Data Management

Version 1.0 (Mar. 2007)


The following table lists all changes that have been made to this Standard Operating Procedure since the original publication date.  Any recommended or required changes added to the log must be complete and concise and promptly brought to the attention of the Project Leader.  The project leader will review and incorporate all changes, officially complete the revision history log, and change the date and version number on the title page.  For complete instructions, please refer to Section II of SOP#10 – Revising the Protocol. 
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	New Version #
	Previous Version #
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I. Document Description
Proper data management and standardization are essential to the effective utilization of information gained through long-term ecological monitoring activities.   This SOP provides guidelines to the NCBN Data Manager (or designated Project Leader) for the development, storage, and distribution of monitoring data associated with the Network’s Ocean Shoreline Position Monitoring Protocol.  The SOP describes how the many disparate pieces of information that are generated at various points in the data-gathering, analysis, and reporting processes are to be organized, stored, and disseminated.

More specifically, this SOP describes the overall file management system for the protocol, as well as the details of monitoring-data storage in a Microsoft Access database.  The SOP also outlines the procedures for performing QA/QC on the data, archiving the various spatial and tabular datasets, and making the data publicly accessible via biological information clearing houses. 
A formal information management plan for all NCBN monitoring protocols is available at http://www.nature.nps.gov/im/units/ncbn/d_im_plan.cfm and should be consulted for more detailed procedural and policy information.
II. Definition of the Ocean Shoreline Dataset

The Ocean Shoreline Monitoring program will produce a number of electronic files that will include formal written reports, GPS and GIS spatial datasets, a Microsoft Access database, and paper field forms.  The large number of files of various formats will require conscientious and formal attention to their management.   
Once initial post-processing and export procedures have been completed by field personnel (see SOP#7), the following datasets will be delivered to the Project Leader in digital format (CD/DVD by mail, compressed archive via email or FTP, etc.): 

1. Original GPS data files (e.g., .ssf format for Trimble units) downloaded from the GPS unit

2. If real-time correction was not employed during data collection, differentially-corrected GPS data files (e.g., .cor format for Trimble units)
3. A cleaned, exported ESRI point shapefile (.shp) (if applicable)
4. A continuous shoreline line-feature shapefile (.shp)

5. A metadata file for the above line shapefile which complies with Federal Geographic Data Committee (FGDC) standards.
6. Original hard-copies or scanned versions of all field data sheets (Adobe .pdf format)
In addition to the collection and initial processing of shoreline positional data, Network-contracted investigators or technicians will periodically conduct analysis of shoreline change using the USGS Digital Shoreline Analysis System (DSAS).  This analysis involves the calculation of distances between multiple shoreline features and an established baseline along pre-defined azimuths, resulting in a matrix of distance measurements that can be used for subsequent statistical trend analyses.  

Finally, investigators will produce annual and long-term (five-year) reports summarizing and interpreting the results from the above analyses. Copies of these reports will be delivered to the Project Leader and stored primarily in Adobe .pdf format.


III. File Management and Documentation
It is the responsibility of the Project Leader to assemble and maintain the various components of the Ocean Shoreline Dataset described above.  The Shoreline Monitoring protocol generates a number of raw data products and reports that are not suitable for direct storage within the database, including uncorrected (.ssf) and corrected (.cor) GPS data files, as well as exported ESRI shapefiles (.shp).  In order to ensure proper functioning of the Shoreline Change Monitoring Database and to generally ease the data retrieval process, the Database User’s Guide (Appendix A) identifies a coherent, consistent directory structure to store data files.  
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Figure S9.1.  Top Level Shoreline Monitoring File Structure

In order for hyperlinks within the database to work properly, the main folder ‘Shoreline_datasets’ (Fig. S9.1) should be placed at the same directory level (i.e., within the same folder) as the Microsoft Access monitoring database itself.  

This directory structure, along with naming conventions for the various file types, is outlined in detail in Section 1.1 of the Database User’s Guide.
A.  Baseline Shoreline Datasets


For each monitoring location, investigators will have developed a generalized shoreline trend line, against which all subsequent GPS’ed shorelines will be compared during shoreline change analyses.  Along with these baselines will be a suite of permanent transects that will be used to measure distances between the shoreline position and the baseline at approximately 10m intervals. (These analyses and the procedures used to generate the baseline and transect datasets are outlined in detail in SOP #8.)  Each baseline and transect dataset is stored in an ESRI Personal Geodatabase as a feature class with tabular attributes required by the USGS’ DSAS shoreline change analysis software.  These geodatabases are then linked to the Shoreline Monitoring Database by the Project Leader according to the steps outlined in the Database User’s Guide, Section 3.1.

B. Raw GPS Data

The original GPS data points are an integral component of the ocean shoreline dataset, allowing for the recreation and replication of any subsequent calculations or derivations.  The raw data file directly downloaded from the GPS data collector contains information beyond the horizontal point position, including precision and accuracy of the position, time and date of collection, equipment used, PDOP, number of satellites, signal to noise ratio, etc.  If Trimble GPS data collectors such as the ProXR or GeoXT are used, these data will be in the proprietary .ssf file format; however, other file formats may be generated depending on which sub-meter accuracy GPS unit is utilized.  

If there is any question as to whether prescribed GPS data collection parameters have been exceeded (see SOP #5), the Project Leader should refer to these files to determine that GPS unit settings for data collection have been correctly applied.

Because these files are typically in non-tabular and proprietary formats, they are linked in the database rather than entered as text.  Step-by-step procedures for linking these files to the Database User’s Guide, Section 5.1.

C.  Corrected GPS Data

Post-processed data products, described in SOP #7, consist of differentially-corrected versions of the raw GPS data file (e.g., a .cor file, in the case of using the Trimble units).  An accompanying log file is created along with the .cor file and contains references to the CORS beacon base files used for correction, as well as estimates of the accuracy of the positions.  This log file should be bundled with the .cor file (i.e., placed alongside the .cor file in the same directory location).   As with the raw GPS file, the .cor file is in a non-tabular and proprietary format and is linked to the Database as opposed to entered as text (see Database User’s Guide, Section 5.1).

It is recommended that Project Leader inspect the .cor and log file in the unlikely event that a substantial number or positions were not able to be corrected with the CORS beacon file that was downloaded by the field technician.  In such cases, correction data from one or more nearby beacons should be downloaded and the original .ssf file re-processed to yield additional corrected positions.  

Note:  Data which have been corrected in real time through the use of a DGPS beacon receiver can be considered corrected data.  However, if field technicians have access to PathFinder Office or other software capable of differential correction, it is encouraged that they still post-process these data using a suitable CORS beacon file.  This would be done to ensure against a substantial number of positions failing to be corrected due to problems such as an unforeseen loss of the beacon signal.

D.  Shoreline Shapefiles

In addition to the .ssf and .cor file, SOP#7 outlines the procedures for correcting the GPS files and creating a cleaned shoreline line-feature shapefile.  This line dataset represents the final GIS product on which all subsequent trend-analyses are based.  Required attributes for these shapefiles are specified in SOP#7.  

Note:  Depending on the equipment and settings used, the initial survey of the GPS shoreline position produces either a continuous line feature or a dataset consisting of a series of points spaced 5-10 meters apart.   If the latter is the case, then the GPS shoreline data must be transformed into a continuous line feature in order permit position-change calculations. Procedures for converting a point dataset to a continuous line dataset are presented in SOP#7.  Variation due to interpolation between the points is minimal because the spacing of the points is dense (less than 10 meters).  If applicable, the point shapefile should be retained in the ‘shp_pts’ folder outlined in Section III above and the location entered in the protocol database as outlined in the Users’ Guide.

The ESRI line shapefile, similar to the raw GPS .ssf and corrected .cor files, is a non-tabular, proprietary data format and is likewise linked to the Shoreline Monitoring Database rather than entered as text.  The steps for doing so are outlined in the Database User’s Guide, Section 5.1.  At a minimum, the Project Leader should inspect this final product for completeness against known, trusted GIS base datasets (e.g., the shoreline trendlines described in SOP #8), as well as ensure that an FGDC-compliant metadata file accompanies the line-feature shapefile.  The metadata file should be included as an .xml document using the same naming conventions as the other components of the multi-file shapefile format.  Metadata in .xml format can be viewed in a number of web browsers and metadata editing software packages, including ESRI ArcCatalog.


Finally, the completed line shapefile and its metadata should be imported into the aforementioned Baseline Shoreline Geodatabase outlined in section A above.  This can be done in ArcCatalog using the following steps:

1. Navigate to the Shoreline_datasets\baselines folder outlined in Section III, above

2. Right-click on the appropriate geodatabase and choose “Import -> Feature class (single)”

3. In the Input Features field browse to the line shapefile

4. In the Output Feature Class field repeat the name of the shapefile, minus the .shp file extension

5. Click OK.

E.  Field Data Forms


The Field Data Form collected in conjunction with the GPS position data provides information essential to the usability and verification of the dataset.  If not already converted, the Project Leader will scan hard-copy field data forms and export them as Adobe .pdf files.  These files are then linked to the Shoreline Monitoring Database according to the steps outlined in the Database User’s Guide, Section 5.1.

In addition to the above electronic versions, all original paper Field Data Sheets will be housed in the NCBN central files at the University of Rhode Island, Kingston, RI.  The central files are maintained by a URI FTSC staff member under the guidance of the Network Data Manager and Coordinator.

F.  Distance Matrices 

Shoreline datasets collected over various periods of time (seasons within a single year, seasons across several years, etc.) are processed relative to a pre-determined baseline shoreline feature generated for each park.  Distances from the baseline to each shoreline are calculated at 10-m intervals at set azimuths (see treatment of analyses using the DSAS program in SOP #8).  The DSAS program provides tools for exporting these distance calculations as a matrix in Excel Spreadsheet Format (.xls) (Fig 9.2), which itself can be assimilated into a Microsoft Access data table.  
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Figure S9.2.  Example Data Matrix in Microsoft Excel spreadsheet format.

As periodic analyses are conducted and annual and long-term reports generated (see SOP #8), additional shorelines will be added to these matrices.  The Project Leader should acquire exported .xls files from the investigators conducting regular shoreline change analyses and incorporate these distance calculations into the Shoreline Monitoring Database each time a new shoreline is entered.  Procedures for doing so are outlined in Section 7 of the Database User’s Guide.

G.  Reports

The final products to be included in the Shoreline Monitoring Database are the regular reports produced in SOP #8.  These reports are completed for each park unit and are of two types:  an annual report summarizing the change in shoreline position over the past year, and a long-term trend report that summarizes and analyzes the trends of changes in shoreline position every five years.  Both types of reports should be delivered to the Project Leader as Adobe .pdf files and linked to the Monitoring Database as described in Section 8 of the Database User’s Guide.

IV. Database Administration and Maintenance

A.  Data Entry QA/QC

The Project Leader will be responsible for entering all pertinent data into the Shoreline Monitoring Database in a timely manner.  To minimize transcription errors, each line of data will ideally be checked against the original field data sheets by a second person.  However, if no staff is available, the Network Data Manager should check 100% of the data entry on the following day.  

B.  Database Backup
Tape backups of the Shoreline Monitoring project directory (including the Shoreline Monitoring Database) will be made daily per an arrangement with the University of Rhode Island Field Technical Support Center (URI FTSC).  Incremental (daily) backups of NCBN data drives are maintained on a weekly basis, culminating in a full backup at the end of each week.  Weekly backup tapes are retained for six months.  One full backup per month is retained in perpetuity, with two redundant copies held in separate off-site data archives.  

C.  Database Revision Control


Because the Shoreline Change Database follows the NPS I&M Program’s Natural Resource Database Template v.3 (NRDTv.3), a table describing database revision history (tbl_Db_Revisions) and linking to the database metadata (tbl_Db_Meta) is an included core table.  Revisions will be performed periodically by or in conjunction with NCBN staff as the need arises and should be documented fully in the above table, as well as in the database metadata produced though cooperative agreement by NCSU FTSC (see Section VII).
The Project Leader will also be responsible for reflecting pertinent changes to the Shoreline Monitoring Database in the accompanying User’s Guide, as well as this Data Management SOP #9.
VI. Export to ASCII for backup

As software and hardware evolve, datasets must be consistently migrated to new platforms, or they must be saved in formats that are independent of specific platforms or software (e.g., ASCII delimited files). Thus, NCBN archiving procedures include saving datasets in both their native format (typically MS-Access or Excel spreadsheet format) and as sets of ASCII text files. As a platform- and software-independent format, ASCII text files ensure future usability of the data in a wide range of applications and platforms.

As part of the annual archiving of the Shoreline Monitoring Database (see section VII below), the NCSU will produce such ASCII text files for all tabular data within the database.  However, if the Project Leader wishes to periodically generate such files for backup purposes at the Network level, a utility to do so written in Microsoft Access called “Exportdb” is available (http://science.nature.nps.gov/im/datamgmt/data_tools/exportdb.mdb). Exportdb will write the following ASCII comma-delimited text files for each database: 
· TABLEDEF.txt - This file will contain one record for every table in the selected database. Fields in the file include Table_Name, Table_Description, Table_Format, Number of Fields, Export_Date. 
· FIELDDEF.txt - This file will contain one record for every column in every table in the selected database. Fields in the file include Table_Name, Field_Name, Field_Description, Field_Type, Field_Width. 
· One comma-delimited ASCII text file containing all the data rows in each table in the selected database. 

Exportdb displays a single form containing three function buttons: 
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The "Clear all attached tables" button will clear all tables linked from 

previous sessions.  The "Link Database Tables" button will open a browse window to allow the selection of the Microsoft Access database to be exported. (Note: the utility will not export tables that are linked to a back-end database. 

The "Export Tables" button will open a browse window to allow selection of the destination directory for the text files. Once a directory is selected, the export will be performed.  

Alternatively, the following procedure can be used to export tables directly from the Monitoring Database:

1. In the Database window click the name of the table to be exported and then on the File menu, click Export. 

2. In the “Save As Type” box, click Text Files (*.txt; *.csv; *.tab; *asc). 

3. Click the arrow to the right of the “Save In” box, and select the drive or folder to export to. 

4. In the File Name box, enter a name for the file (or use the suggested name), and then click Export.

VII. Archiving
NCBN has entered into a cooperative agreement with the North Carolina State University NPS Field Technical Support Center (NCSU FTSC) for the maintenance, storage, and archiving of datasets produced as part of the Networks vital signs monitoring program.  Datasets associated with the Shoreline Change Protocol will be archived on an annual basis, both in their native formats as well as ASCII text files.  Archived datasets will include both tabular data in MS-Access format as well as spatial data. Network staff are responsible for preparing tabular data from the protocol for archival following completion of standard QA/QC procedures.  NCSU FTSC staff then prepares the tabular data for archiving by creating:

· a set of ASCII comma-delimited text files for the tabular data files and tables comprising the dataset 

· an XML file that preserves relationships between tables for each MS-Access database

· a readme.txt file that explains the contents of each ASCII file, file relationships, and field definitions

Quality control checks are then performed on these ASCII files to ensure that the numbers of records and fields correspond to the source dataset and that conversion has not created errors or data loss. If possible, a second reviewer, preferably a program scientist, checks the ASCII files and documentation to verify that tables, fields, and relations are fully explained and presented in a way that is useful to secondary users. 

Digital spatial data associated with short or long-term project data described above will also be archived at the NCSU FTSC. These data include ArcGIS shapefiles, coverages and geo-databases; global positioning system (GPS) data. Procedures for maintaining spatial data differ from those that apply to tabular data.

Spatial data in ArcGIS shapefile format will be maintained in formats that are accessible by the current ArcGIS version.  If necessary, NCSU FTSC is responsible for converting ArcGIS data to an upgraded format.  Shapefiles will also be converted to sets of ASCII text files for archiving. Two ASCII files are required for each spatial data file. One file stores coordinate data with a unique identification code for each feature, and the second file stores attribute information that can be linked to the corresponding coordinate data by means of a common identification code.
On an annual basis, the Data Manger will forward to the NCSU FTSC dataset consiting of the following elements: 
1. an updated Shoreline Change Monitoring database,

2. updated versions of the Baseline Geodatabases for each park unit,

3. line shapefiles metadata for all shorelines collected during the past year,

4. all uncorrected (.ssf) and corrected (.cor) GPS data from which the line shapefiles were created,

5. a digital (.pdf) copy of the field forms from each survey for that year,

6. a digital (.pdf) copy of the final Annual Report, and

7. once every five years, as a copy of the Long-term Report.

When a project dataset is ready to be archived, Network staff will send the data to NCSU FTSC accompanied by a transmittal document in the form of an ASCII text file that includes specific information about the data or imagery. This information includes:

1. name and address of the sender

2. brief project description, including topic and park name(s)

3. type and number of digital media (e.g., 3 CDs, 1 DVD)

4. name of each data file that comprises the dataset (Federal Geographic Data Committee (FGDC) compliant metadata or a data dictionary must be present for each data file)

Upon receipt, NCSU FTSC staff will:

1. check the digital media for physical damage

2. count and record the number of media received

3. count and record the number of data/image files received

4. check data file integrity (i.e. makes sure that each file opens and displays appropriate data)

NCBN staff will be notified if any problems or discrepancies are found.

NCSU staff will enter the information about short-term and long-term monitoring project data into an Excel spreadsheet, referred to as the Digital Data Tracking Database. 

VIII. Data Distribution

Access to NCBN data products will be facilitated via a variety of information systems that allow users to browse, search, and acquire Network data and supporting documents. These systems include the NCBN website (http://www.nature.nps.gov/im/units/ncbn/), and national applications with internet interfaces, such as the NR-GIS Data Store (http://science.nature.nps.gov/nrdata/). 

Because Network data will reside in the repositories listed above, they will automatically be searchable via the integrated metadata and image management system and search gateway called “NPS Focus.” This system is being built with Blue Angel Enterprise software for metadata management and the LizardTech Express Server for image management. Currently, ten NPS and two non-NPS databases have been integrated into the NPS Focus prototype in either full or test bed form for one-stop searching. NPS Focus has been released as an Intranet version only (http://focus.nps.gov/) – release of a public version is projected in the near future.

Requests for data and reports before they are published in the above repositories should be directed to:

Northeast Coastal & Barrier Inventory & Monitoring Network

Data Manager
University of Rhode Island
Room 105 Coastal Institute
1 Greenhouse Road
Kingston, RI 02881
Fax: 401-874-4561 

Standard Operating Procedure (SOP) # 10 – Revising the Protocol

Version 1.0 (July, 2007)

The following table lists all changes that have been made to this Standard Operating Procedure since the original publication date.  Any recommended or required changes added to the log must be complete and concise and promptly brought to the attention of the Project Leader.  The Project Leader will review and incorporate all changes, officially complete the revision history log, and change the date and version number on the title page.  For complete instructions, please refer to Section II of this SOP. 
 
Revision History Log:

	New Version #
	Previous Version #
	Revision Date
	Author (full name, title, affiliation)
	Location in Document and Description of Change
	Reason for Change

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


The following Master Version Table tracks the relationships between the protocol narrative and the associated Standard Operating Procedures, as discussed in Section II. C. of this Protocol.
	Master Version Table: NCBN Ocean Shoreline Position Monitoring Protocol and Standard
Operating Procedures

	Date of Revision
	Protocol 
	Narrative
	SOP #1
	SOP #2
	SOP #3
	SOP #4
	SOP #5
	SOP #6
	SOP #7
	SOP #8
	SOP #9
	SOP #10

	8/16/2007
	1.00
	1.00
	1.00
	1.00
	1.00
	1.00
	1.00
	1.00
	1.00
	1.00
	1.00
	1.00

	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	


 I. Scope and Applicability 

Due to the long-term nature of the NCBN monitoring program, revisions to the Protocol Narrative and to individual Standard Operating Procedures (SOPs) will be necessary from time to time (O’Ney, 2005).  Careful documentation of changes to the Narrative and its related SOPs, along with a library of previous versions, are essential for maintaining consistency in the collection, summary, analysis, and reporting of data. 

The Revision History Logs found at the beginning of the narrative and each SOP list all edits to that section since the original publication date. Information entered in these logs should be complete and concise. The logs track the previous version date and number, date of revision and new version number, author(s) of revision, location of changes within the document, description of change, and the reason the change was made. Author information must include full name, title, and affiliation.  

The Master Version Table found  in SOP #10 – Revising the Protocol tracks the relationships between the narrative and the associated SOP’s.  The use of this table is discussed in detail in Section II.C. below.   


II. Instructions for Recording Revisions

Protocol users must promptly notify the Project Leader about recommended and/or required changes. The Project Leader will then review and incorporate all changes, update the Revision History Log and Master Version Table, and change the date and version number on the title page of the master document as well as any SOPs the revisions apply to.

A. Minor Revisions 
Minor revisions are those that do not represent a change in the underlying methods or procedures used to generate data values for the protocol’s existing data set. Minor revisions include small changes in, or clarification of procedures. Version numbers for minor revisions increase incrementally by hundredths (1.01, 1.02 . . .).

B. Major Revisions 
Major revisions are those that involve changes in methodology that could influence the resulting data values and the ability to compare newly-collected data with data collected using a previous version, such as:
· addition of monitoring objectives

· changes to the sampling design

· changes to reporting requirements
· addition of new variables
Major revisions are designated with the next whole number in the sequence (2.0, 3.0, 4.0...). 

C. Coordinating Narrative and SOP Versions  
In order to track the most current version numbers of all SOPs associated with a particular protocol version, the Project Leader will also maintain the Master Version Table, which immediately precedes the narrative’s Revision History Log.  A new entry must be made each time the narrative and/or any SOPs are modified.  In cases where the narrative and/or one or more SOP have undergone only minor revisions (Section II A above), the overall protocol version number will itself increase incrementally by hundredths.  In cases where the narrative and/or one or more SOP have undergone a major revision (whether or not other sections have undergone minor revisions), the overall protocol version number will increase incrementally by whole numbers (Fig. S10.1).

	This Master Version Table tracks the relationships between the Protocol Narrative and the associated Standard Operating Procedures, as discussed in Section II. C. of SOP #10 – Revising the Protocol.

Master Version Table: NCBN Ocean Shoreline Position Monitoring Protocol and Standard Operating Procedures
Date of Revision

Protocol
Narrative

SOP #1

SOP #2

SOP #3

SOP #4

SOP #5

SOP #6

SOP #7

SOP #8

SOP #9

SOP #10

1/1/2007

1.00

1.00
1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

6/1/2007

1.01
1.01
1.01

1.00

1.00

1.00

1.01

1.00

1.00

1.00

1.01

1.01

8/2/2007

2.00

1.01
1.01

1.00

1.00

2.00

1.01

1.00

1.00

1.00

1.01

1.01

1/10/2008

3.00
2.00
1.01

1.00

1.01

2.01

1.02

1.00

1.00

1.01

1.02

1.01





Fig S10.1. Example of a Master Version Table reflecting possible revision scenarios and associated numbering of the protocol.  

The Project Leader will also update all associated field forms to reflect the change in protocol version. Users noting discrepancies in versions between the protocol, SOPs, data values, and field forms should notify the Project Leader so that corrections can be made and documentation kept current. 

III. Reviewing suggested protocol revisions  
All suggested edits require review by the Project Leader for clarity and technical soundness.  Small changes or additions to existing methods will be reviewed by NCBN staff.  However, if a significant change in methods is recommended, additional expert review may be required.  


IV. Communicating changes to investigators / users
Once changes have been made, the updated document is posted on the NCBN web site (http://www.nature.nps.gov/im/units/ncbn/) and is added to the National Vital Signs Monitoring Protocol Database (http://science.nature.nps.gov/im/monitor/protocoldb.cfm). All previous versions are archived in the NCBN information system and can be obtained by contacting the Data Manager. Each time an SOP is revised, the Project Leader ensures that all known users obtain a current copy of the SOP and receive the necessary briefing material and/or training to understand and incorporate the change(s). Users are encouraged to visit the network web site and/or contact the Project Leader at least once per season to check for updates associated with the monitoring protocol. 

V. References 

O’Ney SE. 2005. Standard operating procedure #11: Revising the protocol, Version 1.0. In: O’Ney, S.E. 2005.  Regulatory water quality monitoring protocol. Version 1.0. Bozeman (MT): National Park Service, Greater Yellowstone Network. 
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Field Data Form - GPS Shoreline Survey

| Event Information

Survey Date: 03-14-07 Protocol/SOP Version: GMP v.1.0/SOP v. 1.0
Park Unit FIIS Date of last storm event (High

Start time: 7:30am Tide > 1ft above predicted): > 14 days

End time: 1:40pm Time of last high tide: 3:45am

Observer's Name: Dennis Skidds Date of closest neap tide: 03-12-07

| GPS Device / Settings

Make (e.g., Garmin, Trimble): Trimble Maximum PDOP (< 6): 6.0
Model (e.g., GeoXT, ProXR, etc.): GeoXT Maximum SNR (< 5) 5.0
Minimum SV's (= 4) 4

Accuarcy w/ differential correction
(should be sub-meter): < 1m (nominal) EHE (< 12m) 12

Measurement interval /

Coordinate System (Projection [e.g., Epoch (< 1sec.) 1s

UTM, State Plane] or Geographic
[specifiy decimal degrees or dd.mm.ss]): UTM

Real-time correction signal,
Datum (e.g., NAD83, NAD27, WGS84): NAD 1983 if used (e.g., CORS, WAAS) N/A

PDOP = Positional Dilution of Precision, SNR = Signal-to-Noise Ratio, SV = Satellite Vehicles, EHE = Estimated Horizontal Error

Survey notes: (any equipment problems, obstacles encountered, etc.)

Time of incident Notes:
(from GPS unit): )
0706 Stopped at jetty at Democrat Pt. Restarted feature collection on other side.
0750 Encountered 2 sets of groins in communities before Wilderness area. Repeated above procedures.
0945 Encountered slurry pipe in beach-nourishment zone. Repeated above procedures.
Data Download
Software used to download data (include version): Microsoft ActiveSync 4.1.0; Trimble Pathfinder Office 2.90
Park Unit: If differentially corrected after downloading, list
all base stations used: Central Islip NY CORS (all points corrected)

Describe any editing of data: Features split, vertices deleted where obstacles encountered
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